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Résumé
Dans cette étude, nous présentons les principales fonctions du simulateur Pspice ainsi

que son langage (la base du logiciel Cadence). Ce dernier est un outil important à l’heure

actuelle en matière de simulation de circuits analogiques et numériques. Créé au début des

années 1970, il constitue encore aujourd’hui l’outil de simulation en génie électrique.

Le logiciel Pspice de MicroSim Corporation, racheté par Orcad, est une version PC du

simulateur Spice. Ce simulateur peut être considéré comme le premier et l’un des principaux

simulateurs analogique/numérique.

Le Pspice comprend un éditeur de schéma, un éditeur de texte et un module

d’affichage des résultats ainsi que d’autres utilitaires qui rendent le logiciel plus agréable pour

l’utilisateur.

Lors de cette étude, nous avons montré que l’outil Pspice permet de posséder un véritable

labo de mesure et d’essai, à moindre coût, et dans un espace restreint. De plus nous sommes

arrivés à mettre en évidence la concordance des résultats obtenus par simulation avec les

résultats théoriques et pratiques.

A partir de la création du schéma d’un montage dont les composants sont décrits par les

modèles fournis en général par les fabricants de semi-conducteurs, PSPICE permet de simuler

le fonctionnement du circuit et de l’analyser finement, tant du point de vue des grandeurs

continues que dans le domaine temporel ou fréquentiel. On peut dire que l’outil regroupe en

même temps les fonctionnalités de mesure du multimètre, de l’oscilloscope et de l’analyseur

de spectre.sa puissance ne s’arrête pas là, on peut réaliser des analyses paramétriques, c’est-à-

dire représenter la variation d’une grandeur du circuit en fonction de la variation d’une autre,

pas nécessairement le temps ou la fréquence.

Nous avons également étudié les différentes étapes de fabrication d’une carte

électronique, en d’autre terme, réalisation d’un circuit imprimé en montrant toute les

fonctionnalités de Layout.
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Introduction

Introduction :

Dans cette étude, nous présentons les principales fonctions du simulateur Pspice ainsi

que son langage (la base du logiciel Cadence). Ce dernier est un outil important à l’heure

actuelle en matière de simulation de circuits analogiques et numériques. Créé au début des

années 1970, il constitue encore aujourd’hui l’outil de simulation en génie électrique.

Le logiciel Pspice de MicroSim Corporation, racheté par Orcad, est une version PC du

simulateur Spice. Ce simulateur peut être considéré comme le premier et l’un des principaux

simulateurs analogique/numérique.

Le Pspice comprend un éditeur de schéma, un éditeur de texte et un module

d’affichage des résultats ainsi que d’autres utilitaires qui rendent le logiciel plus agréable pour

l’utilisateur.

Pour une meilleure explication de l’exploitation de ce logiciel, nous avons divisé notre travail

en trois chapitres.

Le premier chapitre est consacré à l’initiation au Pspice dont l’objectif est de maitriser

les différentes fonctionnalités de l’outil, afin d’éditer un schéma, le simuler sous différentes

formes, puis pouvoir analyser le résultat. Le deuxième périmètre consiste à une approche, en

décrivant la procédure d’écriture d’un programme en langage Spice.

Le deuxième chapitre consiste à l’application, il comprend une série d’exemples

simulés en deux méthodes :

 Simulation par l’éditeur schéma Orcad Capture.

 Simulation par l’éditeur de texte (fichier d’entrée.cir).

Ces exemples servent de support aux différentes fonctionnalités du logiciel.

Et enfin, dans le troisième chapitre, nous avons modélisé les lignes de transmission par

le Pspice, réalisé un circuit imprimé avec Orcad-Capture-layout en décrivant les différentes

étapes de fabrication.
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I-1) Préambule :
Afin de faciliter la conception de systèmes électroniques performants toujours plus

complexes dans des temps toujours plus courts, de nombreux outils de CAO (Conception

Assistée par Ordinateur) ont vu le jour ces 20 dernières années. Ils permettent en autre la

synthèse automatique de circuits et systèmes, le dessin (cartes, ASIC, …), la vérification des

règles, la testabilité. L’avantage premier de la CAO est qu’elle permet d’éviter la phase de

prototypage, ce qui permet en outre une diminution du coût de fabrication.

Figure I.1 : principales étapes de la réalisation d’un système électronique en industrie

La simulation est la première étape dans la conception d’un circuit ou d’un système

électronique,  mais pourquoi simuler ?

Avec l’avènement de l’informatique, tous les outils de simulation  se sont répandus dans tous

les secteurs d’activité. L’électronique ne pouvait pas être épargnée. La simulation donne à

l’ingénieur la possibilité de réaliser, puis de tester un prototype virtuel. Les avantages sont

évidents : économies de temps et d’argent.

Pour l’enseignant la simulation s’impose pour les raisons suivantes :

 Cette technique permet d’obtenir des résultats lorsque le matériel nécessaire manque :

mesurer des courants, calculer la transformée de Fourier d’un signal.

 Pour les étudiants, de nombreux phénomènes sont trop complexes pour une étude

théorique, la simulation permet de montrer ce qu’on n’a pas le temps d’expliquer.

 La simulation est de plus en plus utilisée dans l’industrie, il faut donc y préparer les

ingénieurs et les techniciens futurs.
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I-2) Définition du Pspice :
Dans les années 70, des étudiants en informatique de l’université de Berkeley en

Californie mettent au point un Algorithme destiné à la conception des circuits intégrés

analogiques. Cet algorithme se nomme SPICE (Simulation Program with Integrated Circuits

Emphasis). Par la suite différentes entreprises vont commercialiser des logiciels de simulation

basés sur le noyau SPICE.  L’évolution de l’informatique permettra de porter ces logiciels

successivement sur station de travail puis, à la fin des années 80 sur micro-ordinateurs. La

version de SPICE vendue par Microsim devient le standard de l’industrie sous le nom de

PSPICE. est un logiciel de simulation de circuits électronique. Nous révèle les mesures de

tous les courants et de toutes les tensions avant même de l’avoir construit. Tout est assemblé

et expérimenté sur le pc. Nous pouvons utiliser tous les composants électroniques connus

pour constituer le circuit, résistances, condensateurs, transistors bipolaires et FET. De très

nombreux circuits intégrés sont également disponibles en bibliothèque. Mais on peut définir

soi-même de nouveaux composants, butinés sur Internet ou achetés. Les résultats des

simulations s’accordent généralement très bien avec la pratique, même jusqu’à des fréquences

très élevées. À côté des circuits analogiques, les logiciels modernes de simulation permettent

aussi de traiter des circuits numériques tels que microcontrôleurs, RAM et logique à portes,

mais aussi les antennes et les lignes de transmission.

I-3) Initiation au PSPICE :

I-3-1) L’environnement  de pspice :

Pour simuler, nous avons trois étapes de base : saisie du circuit, calcul, présentation des

résultats.

Figure I .2 : chaine montrant les trois étapes mises en œuvre par Pspice
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 1ère étape : ÉDITEUR : Il existe deux solutions pour décrire le circuit à simuler :

- description par un schéma : dans ce cas, on exploite l’éditeur graphique « Capture ». Quand

le dessin est fini, ce logiciel construit une « netlist », c'est-à-dire une description sous forme

d’un texte du circuit, ainsi qu’un fichier portant l’extension .CIR.

- description par un fichier texte : dans ce cas, il faut un éditeur de texte « Pspice AD ». Le

fichier doit porter l’extension .CIR(ne pas mettre l’extension .txt ou .doc).

 2eme étape : PSPICE lit le fichier .CIR : soit celui généré par l’éditeur graphique, soit

celui écrit par l’utilisateur. Pspise exécute les calculs demandés, donne certaines informations

importantes dans un fichier .OUT et stocke les résultats dans un fichier Probe.DAT, destinés

au logiciel de tracés de courbes.

 3eme étape : PROBE : le logiciel « PROBE » exploite le fichier probe.DAT et présente

à l’écran les courbes demandées.

I-3-2) Simulation par l’éditeur schéma :
I-3-2-1) Lancement de capture :

Pour dessiner un schéma électronique, on va utiliser Orcad Capture.

Pour lancer le programme il faut :

Soit cliquer sur l’icône :

Soit aller dans le menu :

Démarrer→ Tous les programme→ OrCAD Demo→ Capture CIS Demo

I-3-2-2) Création d’un nouveau projet :

Pour créer un nouveau projet, on clique sur l’icône (create document), où bien faire :

File→ New→ Project

Une fenêtre s’ouvre, permettant la création d’un projet de différents types :

 Schéma avec simulation des circuits analogique ou mixte (analogiqe et

logique)) → Analog or Mixed A/D.

 Routage→ PC Board Wizard.

 Développement de circuit programmable→ Programmable Logic Wizard.
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 Schématique seul→ Schématic.

Figure I.3: fenêtre de création de projet

 On spécifie un nom fonction du schéma qu’on veut faire. Pour le nom, les

chiffres et quelques caractères particuliers ainsi que l’espace peuvent être

utilisés, mais les lettres accentuées sont interdites.

 On spécifie un nom de répertoire pour le stockage de tous les fichiers du

projet (exemple : E :), soit en tapant directement le nom du répertoire, soit en

cliquant sur « Browse ». Il est préférable d’utiliser un répertoire spécifique

pour chaque nouveau projet, le nombre de fichiers générés pouvant être

relativement important.

 On valide en cliquant sur « OK ».

Une fenêtre demande alors si on souhaite utiliser une trame pour notre projet, ou si on préfère

travailler sur un projet vierge. Nous choisissons cette dernière option avec « create a blank

project », puis on clique sur «Ok ».
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Figure I.4 : fenêtre de création de projet existant/non existant

I-3-2-3) Travail sur un projet existant :

Dans le cas d’un projet déjà existant, on clique sur l’icône (Open document), ou bien

faire : File→Open→Project.

La fenêtre suivante permet de choisir le répertoire et le nom du projet souhaité.

Figure I.5 : fenêtre permettant l’ouverture d’un projet existant

Une autre possibilité, consiste à choisir dans le menu « File » l’un des derniers projets ouverts

(listés au dessus de l’option « Exit »).
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I-3-2-4) Icônes -Unités :
I-3-2-4-1) Icônes :

I-3-2-4-1-1) Barres d’icônes d’OrCad Capture :

Les icônes spécifiques à la simulation sont :

L’icône « simulate » est :
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La barre d’icône de saisie de schéma :
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I-3-2-4-1-2) Barres d’icones de Orcad Pspice :

Barre d’icones « Probe » :

Barre d’icones « File » :
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Barre d’icones « Cursor » :

Barre d’icones « View » :

I-3-5-2) Unités :

Les valeurs numériques doivent être spécifiées avec le point décimal et non la virgule

(exemple : 7,4 mH interdit).

Le symbole des unités des différentes grandeurs (Tension, Courant, Capacité, Fréquence…)

peut être mentionné, mais ce n’est pas une obligation. Seul le symbole Ω ne peut être spécifié.

Il est formellement interdit de laisser un espace entre la valeur numérique et l’unité

(ex : 4.7 mH interdit).
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Les préfixes des unités doivent respecter la syntaxe suivante :

Symbole Unité Multiple

F ou f fento 10-15

P ou p pico 10-12

N ou n nano 10-9

U ou u micro 10-6 (symbole μ interdit)

M ou m milli 10-3 (ne pas confondre avec meg)

K ou k kilo 103

MEG ou meg méga 106 (ne pas utiliser M : milli!)

G ou g giga 109

T ou t Téra 1012

I-3-2-5) Liste des éléments simulables avec Pspice et référence imposée :

 Sources I, V :

 Indépendantes :

 Continues : IDC, VDC

 Fréquentielles : IAC, VAC

 Temporelles : VEXP, ISIN, VPULSE, IPWL, VSSFM, …

 Dépendantes linéaires :

 Source de Courant Commandée en Courant F

 Source de Courant Commandée en Tension G

 Source de Tension Commandée en Courant H

 Source de Tension Commandée en Tension E

 Dépendantes non-linéaires B
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 Composants Passifs :

 Résistance R

 Capacité C

 Inductance L

 Lignes de transmission :

 Ligne sans perte T

 Lignes avec pertes O

 Lignes RC uniformément distribuées U

 Composants Actifs :

 Diode D

 Transistor bipolaire Q

 Transistor MOS M

 Transistor JFET J

 Transistor FET à AsGa B

 Transistor MESFET Z

 Amplificateur Opérationnel (LM324, …) X

 Circuits logiques (Inverseur, Bascules, …) X

 Convertisseur Analogique-Numérique (CAN) O

 Convertisseur Numérique- Analogique (CAN) N

 Composants Particuliers :

 Interrupteurs Commandés

 En Tension S

 En Courant W

 Couplage inductif K

 Source logique U

 Sous – Circuit X

 Composants numériques :

Toutes les fonctions de base: NOT, OR, NOR, AND, NAND, JK, convertisseur A/N,

N/A, ROM, RAM, …
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I-3-2-6) Contenu sommaire des librairies Pspice :

ABM :

Blocs fonctionnels : additionneurs, soustracteurs, dérivateurs, intégrateurs, filtres, fonctions

mathématiques et trigonométriques, transformée de Laplace, table de correspondance, etc.

ANALOG :

Résistances, condensateurs, inductances, lignes de transmission, transformateurs, sources de

tension et de courant contrôlées en tension et en courant.

ANALOG_P :

Résistances, condensateurs, inductances, résistances variables, varistances.

BREAKOUT :

Interrupteurs contrôlés en tension(Sbreak).

Interrupteurs contrôlés en courant (Wbreak).

EVAL :

Environ vingt composants analogiques et cent quarante composants numériques. La liste peut

être augmentée en important des modèles.

SOURCE :

Sources de tension et de courant analogiques, générateurs numériques.

SOURCESTM :

Sources de stimuli, deux analogiques et six numériques.

SPECIAL :

Éléments de contrôle de la simulation.



Chapitre I                                                                                                                    Initiation au Pspice

14

I-3-2-7) Listes des fonctions mathématiques disponibles dans Orcad Capture:

Fonction signification Fonction signification

ABS(x) LOG10(x)

ARCTAN(x) tan-1(x) M(x) Amplitude de x

TAN(x) Tan(x) MAX(x) Maximum de la
partie réelle de x

AVG(x) <x(t)> ou MIN(x) Minimum de la partie
réelle de x

AVGX(x, d) <x(t)> ou (sur
l’intervalle

P(x) Phase de x, le résultat
est en degrés

COS(x) Cos(x) PWR(x, y)

d(x) par exemple si

l’axe des abscisses
est le temps.

R(x) Partie réelle de x

DB(x) RMS(x) Valeur efficace de x

EXP(x) S(x)

G(x) Retard de groupe SGN(x) +1 si x>0

0 si x=0

-1 si x<0

IMG(x) Partie imaginaire

de x

SIN(x) Sin(x)

LOG(x) Ln(x) SQRT(x)
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I-3-2-8) Gestionnaire de projets :

Le gestionnaire de projets (Project Manager) est l’élément central des projets

réalisés sous capture. Il permet de visualiser les différents fichiers constituant le projet. Sa

fenêtre est toujours ouverte. L’activation du gestionnaire de projets s’effectue en cliquant sur

sa fenêtre ou en cliquant sur l’icône (Project Manager).

Figure I .6 : gestionnaire de projets
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I-3-2-9) Saisie de schéma et simulation :

I-3-2-9-1) Le minimum à connaitre avant la saisie d’un schéma :

I-3-2-9-1-1) Activation de la page schéma :

La saisie du schéma ne peut se faire que lorsque la page schéma est active. Si ce n’est

pas le cas, il est nécessaire de la sélectionner à partir du Gestionnaire de projets.

Il est possible que l’icône de la page schéma ne soit pas visible. Dans ce cas :

 On sélectionne la fenêtre du Gestionnaire de projets en cliquant sur l’icône .

 On double clique sur Design Ressources.

 On double clique sur « Nom_De_Projet.DSN ».

 On double clique sur le dossier schéma (« SCHEMATIC1 » par défaut : peut être

renommé par l’intermédiaire du menu contextuel).

 On double clique sur la page schéma (« PAGE1 » par défaut : peut être renommé par

l’intermédiaire du menu contextuel).

I-3-2-9-1-2) Sélection :

La sélection d’élément du schéma s’effectue lorsque l’icône (Select) est active.

La sélection d’un élément (composant, fil de connexion, texte…) s’effectue en cliquant sur

celui-ci : il devient actif et change de couleur (rose). Pour sélectionner plusieurs éléments, il

est possible d’utiliser l’une des méthodes :

 Sélection du premier élément, puis tout en maintenant la touche « CTRL » appuyée,

on sélectionne les éléments suivants ;

 On entoure à la souris la zone contenant les éléments à sélectionner.
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I-3-2-9-1-3) Commandes d’édition :

Différentes commandes d’édition sont disponibles :

 Annulation : une modification malencontreuse effectuée sur le schéma (effacement,

déplacement, placement d’un élément …) peut être annulée (aussitôt) grâce à

Edit→Undo… ou raccourci clavier « CTRL + Z ». Il ne peut s’agir que de la dernière

action.

 Déplacement : pour déplacer un élément ou un bloc, sélectionner à la souris l’élément

ou le bloc désiré, puis le déplacer à la souris.

 Effacement : pour effacer un élément ou un bloc, sélectionner à la souris l’élément ou

le bloc désiré, puis l’effacer en choisissant Edit→Delete ou menu contextuel – Delete

ou raccourci clavier « Suppr » (ou « Delete »).

 Copie : pour copier un élément ou un bloc, sélectionner à la souris l’élément ou le

bloc désiré, puis copier en choisissant Edit→Copy ou menu contextuel – Copy ou

raccourci clavier « CTRL + C ». La copie a lieu effectivement en faisant : Edit→

Paste ou menu contextuel – Paste ou raccourci clavier « CTRL + V » à l’endroit

souhaité.

Remarque :

Dans le cas de la copie d’un composant, le repère du composant copié reste identique à

l’original (il est donc présent 2 fois sur le schéma).

I-3-2-9-1-4) Taille du schéma / Cartouche :

 La taille par défaut du schéma correspond au format A4. Pour changer celui-ci, choisir

Options→Schematic Page Properties, puis sélectionner le format souhaité.

 Le cartouche comprend certaines informations utiles (Date/ Taille/ N° page …).

Mentionner le nom de l’auteur ainsi que le titre du document en double cliquant sur

« a mentionner ».
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Figure I.7 : le cartouche

I-3-2-9-1-5) Sauvegardes :

La sauvegarde du schéma s’effectue en cliquant sur l’icône (save document) ou en

choisissant File→ save ou raccourci de clavier « CTRL+S ».

La nature des fichiers sauvegardés dépend de la fenêtre active :

 Page schéma active : seul le schéma est sauvegardé.

 Gestionnaire de projets actif: l’ensemble des fichiers du projet est sauvegardé.

Remarque :

En quittant Capture, si une modification non enregistrée a été effectuée, la fenêtre

suivante apparait :

Figure I.8 : l’enregistrement des modification

Yes : sauvegarde du fichier schéma seulement.

Yes All : sauvegarde de tous les fichiers du projet.

No : annule la sauvegarde du fichier schéma.

No All : annule la sauvegarde de tous les fichiers du projet.
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Cancel : annule la commande Quitter.

I-3-2-9-1-6) Recherche des composants:

Si on sélectionne une librairie, par exemple « eval », on va faire apparaitre dans la

« Part List » la liste des composants constituant cette librairie. En choisissant un composant

particulier, on peut le visualiser en bas à droite de la fenêtre principale. En utilisant les flèches

de direction du clavier, haut et bas, on peut visualiser la totalité des composants de cette

librairie.

Figure I.9 : fenêtre de placement de symboles

On sélectionne le composant, puis «Ok ».

I-3-2-9-1-6-1) Recherche automatique :

 Recherche automatique dans une librairie :

On peut également lancer une recherche automatique directement dans la librairie

choisie, en renseignant le champ « Part ». Il faut utiliser le caractère * pour remplacer une

partie du nom du composant dont on n’est pas certain.

Exemple : on cherche par exemple le transistor 2n2222. Il suffit de mentionner « *22* » dans

le champ « Part », cliquer sur « Ok ». Le monteur de recherche trouvera :
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On voit ici l’importance des caractères * : 2n2222 est inconnu, seule la référence

Q2n2222 sera reconnue par le moteur de recherche PSpice. Il est donc très prudent d’encadrer

les noms des composants par le caractère*.

On sélectionne le composant, puis «Ok ».

 Recherche automatique générale :

Dans le cas ou l’on ne connait pas la librairie où est stocké l’élément recherché, on

utilise le bouton « Part Search », puis l’on renseigne le champ « Part Name » en insérant des

caractères * pour plus de sécurité.  On visualise ensuite le nom du composant et le nom de la

librairie, s’ils existent.

I-3-2-9-1-7) Modification d’orientation :

Lors du placement d’un composant ou après celui-ci (lorsqu’il est sélectionné), il est

possible de :

 Le faire tourner : menu contextuel – Rotate ou raccourci clavier « r ».

 Lui faire subir une symétrie horizontale : menu contextuel – Mirror Horizontally ou

raccourci clavier « h ».

 Lui faire subir une symétrie verticale : menu contextuel – Mirror Vertically ou

raccourci clavier « v ».

I-3-2-9-1-8) Définition des paramètres d’un composant :

Pour définir les paramètres d’un composant, il suffit de double cliquer sur la valeur ou

sur le nom, et la fenêtre suivante apparait, saisir la valeur souhaitée et cliquer sur « OK ».
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Figure I.10: attribuer un nom pour le composant

Figure I.11 : donner la valeur du composant

Remarque :

On peut changer le nom de chaque composant, à condition de ne pas utiliser des

symboles particuliers : (, :, « ;, / etc).

Les valeurs numériques comportent des préfixes, mais il n’est pas indispensable de

préciser l’unité.
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I-3-2-9-2) Saisie du schéma :

I-3-2-9-2-1) Placement de composants :

Le placement de composants s’effectue en cliquant sur l’icône (Place Part) ou

Place→ Part, ou bien raccourci clavier « p ».

Ceci permet d’ ouvrir la fenêtre suivante :

Figure I.12 : fenêtre de selection des composant

I-3-2-9-2-2) Placement des générateurs et stimulis :

Le placement des générateurs et stimulis  s’effectue comme pour le placement d’un

composant : en cliquant sur le bouton « Place Part » ou Place→ Part, ou bien raccourci

clavier « p ».
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I-3-2-9-2-3) Les sources :

a) Sources analogiques :

Référence de tension :

Toute simulation nécessite obligatoirement une référence de tension : le symbole de

masse dont le nom est 0.    Symbole :

Ce symbole est placé sur le schéma par l’intermédiaire de l’icône (Place

Ground) ou Place→ Ground ou raccourci clavier « g ».

Les différentes sources analogiques, accessibles dans la librairie « SOURCE.OLB »,

présentent des propriétés spécifiques. Chaque source de tension (il existe l’équivalent pour

des sources de courant) est représentée ainsi que les différentes propriétés associées. Certaines

de celles-ci sont visibles et modifiables directement sur le schéma. D’autres ne le sont que par

l’intermédiaire de l’éditeur de propriétés.

V DC : tension continue : utilisée pour les sources d’alimentation, quelque soit le type de

simulation.

Vdc            Tension continue

V AC : tension sinusoïdale : ne convient que pour les analyses fréquentielles

Vac             Amplitude de la composante sinusoïdale

Vdc Valeur moyenne
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V SIN : tension sinusoïdale : cette source permet d’effectuer une simulation temporelle.

Elle convient néanmoins pour une simulation fréquentielle, à condition de spécifier une valeur

dans la propriété « AC » (invisible par défaut).

VOFF Offset value valeur moyenne

VAMPL    Amplitude amplitude

FREQ       Frequency fréquence

TD Time delay retard 0 par défaut

DF Damping factor facteur d’amortissement          0 par défaut

PHASE Phase angle déphasage 0 par défaut

V PULSE : tension « rectangulaire »

V1        Initial value           niveau bas

V2 Pulse value niveau haut

TD      Delay                      retard

TR       Rise time               temps de montée   (>0 !)
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TF       Fall time temps de descente (>0 !)

PW     Pulse width             durée au niveau haut

PER    Period                     période

Remarque:

Ce type de source est évidemment utilisé en analyse transitoire. Si on effectue une

analyse fréquentielle, la source devient sinusoïdale et utilise les paramètres AC et DC. On doit

aussi noter que TF et TR ne doivent pas être nuls (ce qui correspond à la réalité). Pour avoir

des signaux « carrés », il faut utiliser de très faibles valeurs.

V SRC : source de tension générique : convient pour les sources d’alimentation, ainsi que les

analyses continues et fréquentielles.

Vdc Tension continue

Vac         Amplitude de la composante sinusoïdale

V EXP : tension « Exponentielle »

V1                Initial value valeur initiale (à t = 0)

V2 Peak value valeur asymptotique
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TD1              Rise delay retard (0 par défaut)

TC1 Rise time constant constante de temps de montée

TD2              Fall delay temps avant la descente

TC2              Fall time constant constante de temps de descente

Remarque :

Si la valeur asymptotique est inférieure à la valeur initiale, les termes « descente » et

« montée » (« Fall » et « Rise ») sont permutés.

V SFFM : tension modulée en fréquence

VOFF Offset value valeur moyenne

VAMPL Amplitude amplitude

FC Carrier frequency fréquence de la porteuse

MOD Modulation index index de modulation (0 par défaut)

FM Modulation frequency fréquence de modulation
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V PWL : tension définie par segments

La courbe est définie par des paires de valeurs : (temps, tension). Il ne peut s’agir d’une

tension périodique.

Remarque :

Comme la source de signal carré, ce type de source est évidemment utilisé en analyse

transitoire. Si on effectue une analyse fréquentielle, la source devient sinusoïdale et utilise les

paramètres AC et DC.

b) Autres sources :

Il est possible d’utiliser le symbole ci-dessous, accessible dans la librairie «

SOURCESTM.OLB », puis de lui affecter un stimulus : définition d’un signal d’entrée. Ceci

s’effectue grâce à l’éditeur de stimulus, en sélectionnant ce symbole, puis en choisissant

l’option Edit→ PSpice stimulus.

Cette source est utilisable en analogique (stimulus EXP / PULSE / PWL / SFFM / SIN) et en

logique (stimulus CLOCK / SIGNAL).

VSTIM
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c) Sources logiques :

Les pseudo-symboles :

Ils permettent de fixer les états logiques sur une entrée. Ces pseudo-symboles sont disponibles

par la commande « Place, Power » (ou par le bouton PWR de la barre d'outils).

L'horloge numérique :(DigClock de la bibliothèque SOURCE)

Ce stimulus permet de définir un signal d'horloge périodique. On peut programmer les

paramètres suivants :

OFFTIME : durée de l'état bas

ONTIME : durée de l'état haut

DELAY : temps de retard pour le déclenchement du signal

STARTVAL = 0

OPPVAL = 1

Les stimuli numériques de 1 - 4 - 8 - 16 bits : (STIMx de la bibliothèque SOURCE)
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Ce stimulus permet de définir 16 états pour une ligne (1bit) ou un bus (4, 8 ou 16 bits). On

programmera les couples temps - valeur numérique (16 au maximum). Les stimulus de 4, 8 et

16 bits doivent être obligatoirement reliés à un bus.

Code utilisé pour les valeurs numériques :

Stimulus 1 bit : binaire sur 1 chiffre

Stimulus 4 bits : binaire sur 4 chiffres

Stimulus 8 bits : binaire sur 8 chiffres

Stimulus 16 bits : hexadécimal sur 4 chiffres

Exemple de paramètres pour un stimulus de 16 bits :

On accédera à la boite de dialogue ci - dessous par un double clic sur le symbole du

stimulus.

Figure (I.13) : précision des commandes dans la fenêtre d’édition d’un stimulus

I-3-10-2-3) Placement de liaisons :

 Liaisons simples (fils) :

Les liaisons entre les composants s’effectuent en cliquant sur l’icône (place wire)

ou Place→ Wire, ou bien raccourci clavier « W ». Ne pas confondre avec l’icône (place

line) : correspond au placement des traits, non des liaisons électrique.

Pour terminer le tracé des liaisons, il est nécessaire de choisir dans le menu contextuel « End

Mode ».
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Veiller à ce que, les broches des composants soient connectées  à un fil et non directement,

broche à broche.

Les fils se croisant avec connexion, doivent comporter une jonction obtenue avec l’icône

(place junction) ou place→ junction, ou bien raccourci clavier « j ». En cas d’erreur, le

placement  d’une jonction sur une jonction superflue, permet de l’enlever.

 Liaisons multiples (bus) :

Pour regrouper plusieurs  fils dans un bus, mentionner  pour chacun d’eux  en plus

d’un label, un point d’entrée de bus grâce à l’icône (place bus entry), ou place→ bus

entry ou bien raccourci « e ». Rassembler les différents fils en utilisant l’icône (Place

bus) ou Place→ Bus, ou bien raccourci clavier « b ».

Figure I.14 : placement de bus

I-3-2-9-2-5) Identification des liaisons :

Les équipotentielles (Net) peuvent être identifiées par un label ou Net Alias, grâce à

l’icône (Place Net Alias) ou Place→ Net Alias, ou bien raccourci clavier « n ».

Un nom d’alias se terminant par un chiffre, sera automatiquement incrémenté pour le suivant.

Un nom d’alias ne doit pas comporter de lettre accentuée, ni d’espace.

Un bus sera nommé de façon suivante : D [7..0] avec D7 bit de poids à gauche.

Un alias peut être placé uniquement, lorsque l’extrémité du curseur de la souris se trouve sur

un fil ou un bus.
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Toute tentative de placement d’un alias ailleurs que sur un fil ou un bus sera refusée.

Les alias permettent d’identifier des liaisons, sans que celle-ci soient effectivement

représentées par des fils.

I-3-2-9-2-6) Placement  des appareils de mesure :

Une fois le schéma complètement dessiné, il convient de "brancher" nos appareils de

mesure afin de visualiser le comportement de notre montage. On utilisera pour ce faire les

boutons Voltage Marker et Current Marker.

On ne procède pas exactement comme on le ferait avec un voltmètre ou un ampèremètre réel :

le voltmètre et l’ampèremètre ne possède qu’une borne:

 Le voltmètre mesure toujours par rapport à la masse (GND_EARTH) (sauf avec le

voltmètre différentielle qui lui possède alors 2 bornes).

 L’ampèremètre lui aussi ne possède qu’une borne ; il suffit juste de le « poser » sur la

borne du composant, duquel on souhaite connaître le courant.

Ce ne sont pas les seules différences, notons par exemple que ces « markers » se comportent

plutôt comme un oscilloscope (simulation temporelle), ou comme un analyseur de spectre

(simulation fréquentielle). Pour résumer, ces outils sont bien plus puissants et pratiques que

les appareils réels, mais n’oublions pas que nous sommes dans un domaine virtuel et que la

réalité est parfois plus complexe (d’un point de vue résultat de mesures).

Cliquez sur le bouton Voltage Marker: une "pointe de touche", avec une bulle contenant un V,

apparait au bout du curseur de la souris. Déposez le marker sur le schéma de manière à ce que

la pointe de touche se place sur le fil (wire) ou la connexion (pin) voulue. Il faut prendre garde

de ne pas placer le marker ailleurs, sous peine d'un message d'erreur. S'il n'est pas

correctement placé, le marker sera ignoré par le module de simulation.
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Figure I.15 : figure montrant les appareils de mesure (les sondes)

Notez bien que la tension sera mesurée entre le point choisi et la masse, qui sert de référence.

Le « current marker », quant à lui, doit être placé sur une broche d'un composant à 2, 3 ou 4

connexions, et non sur le composant lui-même ou sur un fil de câblage.

En cas d'erreur, vous aurez droit à ce message:

Figure I.16 : le placement du marker de courant est erroné

Cliquez sur OK pour effacer le message et replacez correctement votre ampèremètre, par

exemple sur une connexion d'une résistance ou bien une borne d'une pile (VDC).

Pour supprimer un marker: sélectionnez-le en cliquant dessus, puis Edit/Cut, ou l'icône

"ciseaux", ou la touche Suppr.
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I-3-2-9-3) Simulation :
I-3-2-9-3-1) Création d’un profil de simulation (préparation d’une simulation) :

Pour réaliser une simulation, il faut définir les paramètres des grandeurs variables.

C’est-à-dire la gamme de variation, le pas de calcul, ainsi que d’autres informations qui seront

vues ultérieurement, mais on doit d’abord créer un profil de simulation  en cliquant sur l’icône

(new simulation) ou pspice→ new simulation profile, et indiquer un nom sur la fenêtre

qui s’affiche :

Figure I.17 : création d’un profil de simulation

Cliquer sur « Create », la fenêtre suivante apparait :
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Figure I.18 : définir le type de l’analyse et les paramètres de simulation

Elle  nous permet de définir les paramètres de simulation et  le type d’analyse, qui peut être :

 Temporelle (l’axe des abscisses est le temps),

 Fréquentielle (l’axe des abscisses est la fréquence),

 Continue (l’axe des abscisses est une grandeur continue),

 De polarisation (pas de courbes affichées, juste des points de polarisation),

 Paramétrique (plusieurs courbes associées à un paramètre sont affichées en fonction du

temps, de la fréquence, d’une variable continue … suivant la demande).

Valider par « OK ».

Un fichier apparait alors dans le Gestionnaire de projets, dans la section « PSpice Resources /

Simulation Profiles » :
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Figure I.19 : fenêtre de gestionnaire de projets montrant le profil de simulation actif

I-3-2-9-3-2) Types de simulation :

I-3-2-9-3-2-1) Analyse temporelle « Time Domain(transient) »:

Une analyse temporelle (transient ou TRAN) correspond à une simulation en fonction

du temps. La fenêtre suivante explique en détail l’option(Time Domain) :

Profil de simulation actif
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Figure I.20 : choix de l’analyse transitoire et ces paramètres associés

Remarque :

Dans ce cas de simulation, préciser :

 Durée de simulation ;

 Pas de calcul maximal ; dans la plupart des cas, on peut laisser le logiciel gérer seul ce

paramètre ; si les résultats semblent étranges, se poser cependant la question du choix

d’un pas de calcul plus fin.

I-3-2-9-3-2-2) Analyse fréquentielle « AC Sweep/Noise » :

AC Sweep/Noise, permet d'obtenir un graphe en fonction de la fréquence, c’est donc

une analyse harmonique (Bode, Nyquist, Black). L'étude est faite en sinusoïdal petits signaux,

en linéarisant les modèles autour du point de repos calculé. L'étude est faite d'une fréquence

min à une fréquence max, soit linéairement, ou de manière logarithmique.

Comme indiqué sur cette fenêtre :
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Figure I.21 : choix de l’analyse fréquentielle et ces paramètres associés

I-3-2-9-3-1-2) Analyse continue « DC Sweep » :

Une analyse continue (DC Sweep ou DC), permet d’effectuer une simulation en fonction

d’une grandeur pouvant être :

 Une tension.

 Un courant.

 Un paramètre global.

 Un paramètre de modèle de simulation.

 Une température.
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La fenêtre suivante explique l’option :

Figure I.22 : choix de l’analyse continu et ces paramètres associés

I-3-9-3-2-4) Analyse de polarisation « Bias Point » :

Bias Point : Calcul du point de repos appelé, point de polarisation. Ce calcul est

automatiquement lancé pour permettre le démarrage des autres simulations. Il est

indispensable pour d'autres analyses qui en dépendent. Dans le cas de l'analyse harmonique

(AC), les caractéristiques non linéaires de certains composants (Ex: transistors, diodes...) sont

linéarisées (approximation par la tangente) à l'endroit du point de repos.

I-3-9-3-2-5) Analyse paramétrique :

Une analyse paramétrique, permet d’effectuer une simulation temporelle, ou

fréquentielle, ou continue, avec en plus la variation d’une grandeur pouvant être :

 une tension.

 un courant.

 un paramètre global.

 un paramètre de modèle de simulation.

 Une température.
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Comme le montre la fenêtre suivante :

Figure I.23 : choix de l’analyse parametrique et ces paramètres associés

I-3-2-9-2-3) Modification d’un profil de simulation :

La modification des paramètres de simulation peut s’effectuer :

 Soit dans OrCad Capture, en choisissant l’option PSpice→ Edit Simulation Settings,

ou bien en cliquant sur l’icône ;

 Soit dans OrCad PSpice, en choisissant l’option Simulation→ Edit Profile, ou en

cliquant sur l’icône .

I-3-2-9-2-4) Ajout d’un profil de simulation :

Il est possible, pour un même schéma, de définir plusieurs simulations (plages de

fréquences différentes pour une analyse fréquentielle par exemple). L’ajout d’un profil de

simulation s’effectue dans OrCad Capture, en cliquant sur l’icône .

Spécifier un nom pour la simulation souhaitée (exemple : temporelle ou frequentielle...).

Sélectionner, éventuellement, un profil précédemment défini comme modèle dans la boîte «

Inherit from » :
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Figure I.24 : ajout d’un profil de simulation

Un nouveau fichier apparaît alors dans le Gestionnaire de projet, dans la section « PSpice

Resources / Simulation Profiles »

Figure I.25 : le gestionnaire de projets montre que la 2ème simulation est active et la 1ère

est inactive

Le choix du profil de simulation à prendre en compte pour la prochaine simulation s’effectue

en :

 cliquant du bouton droit de la souris sur le nom du profil de simulation souhaité

Profil de simulation inactif

Profil de simulation actif
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 choisissant dans le menu contextuel l’option « Make active »

L’icône associée au profil de simulation choisi, présente alors un point d’exclamation ( !) et

devient rouge.

I-3-2-9-2-5) Lancement d’une simulation :
Le lancement d’une simulation entraîne les actions suivantes :

 vérification de l’annotation des composants (numérotation des repères).

 génération du fichier Netlist.

 calcul des différents courants et tensions du schéma en fonction de l’analyse demandée.

 affichage des courbes des courants et tensions pour lesquels une « sonde » a été placée sur le

schéma.

Il s’effectue en choisissant :

 dans OrCad Capture : l’option PSpice - Run ou en cliquant sur l’icône

 dans OrCad PSpice : l’option Simulation - Run ou en cliquant sur l’icône

Le lancement de la simulation entraine l’ouverture de la fenêtre d’affichage des résultats,

comme l’indique la figure suivante :

Figure I.26: fenêtre d’affichage des résultats de simulation
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I-3-2-10) Erreurs possibles :

Le lancement de la simulation peut provoquer les erreurs suivantes :

 erreur d’annotation de composants : une fenêtre dans Orcad Capture mentionne cette

erreur.

Le détail est affiché dans le fichier « Session Log ». Afficher celui-ci en choisissant

l’option Window→ Session Log.

Solution :

Lancer une annotation automatique, ou modifier chacun des repères des composants

comportant une erreur.

 oubli d’un symbole de masse servant de référence pour le calcul de toutes les tensions.

Ce symbole est indispensable à toute simulation analogique. Le message d’erreur

s’affiche dans OrCad PSpice :

ERROR -- Node N00022 is floating

Solution :

Placer le symbole de masse sur le schéma (nom du symbole : 0)

grâce à l’icône (Place Ground).

 le modèle de simulation d’un composant n’a pas été trouvé parmi les librairies de

modèles sélectionnées par défaut. Le message d’erreur s’affiche dans OrCad PSpice :

ERROR -- Subcircuit 7400A used by X_U1A is undefined

Solution :

Vérifier la liste des librairies de modèles de simulation en choisissant l’onglet

« Libraries » du profil de simulation.

 un composant utilisé sur le schéma ne comporte pas les paramètres nécessaires pour

une simulation (exemples : Bornier, Connecteur ou composant choisi dans une

librairie de symboles incorrecte). Un point vert signale cette erreur sur le schéma.

Ceci se produit pour un schéma destiné à la simulation et au routage.
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I-3-2-11) Exploitation d’une simulation :
I-3-2-11-1) Affichage des points calculés :

Lors d’une simulation temporelle, le pas de calcul (step size) est adapté

automatiquement en fonction de la variation des grandeurs calculées : une variation forte

entraîne une diminution du pas de calcul.

Pour une simulation fréquentielle ou continue, le nombre de points de calcul est spécifié dans

le profil de simulation.

Dans certains cas, le résultat obtenu manque de précision, afficher alors les différents

points de calculs en cliquant sur l’icône .

Si on constate des points de calculs trop espacés, on diminue le pas de calcul maximum

(maximum step size) ou bien on augmente le nombre de points de calcul, en modifiant le

profil de simulation (icône ), puis on relance une simulation (icône ).

Attention : un pas de calcul trop faible entraîne une durée de simulation excessive.

Figure I.27 : visualisation des points calculés
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I-3-2-12) Ajout de courbe :

Le lancement d’une simulation provoque le calcul de toutes les tensions et tous les courants

du schéma.

L’ajout d’une courbe, nécessite seulement l’ajout d’une sonde (icônes ) dans

OrCad Capture sur le schéma. Il n’est pas utile de relancer une simulation complète : la

courbe apparaît aussitôt dans OrCad PSpice.

La visualisation de courbes dans OrCad PSpice peut correspondre à des opérations

mathématiques entre plusieurs courbes, comme par exemple : 20LOG10 (V(S) / V(E)).

Ceci s’effectue en choisissant l’option Trace→ Add Trace, ou en cliquant sur l’icône .

La fenêtre suivante permet de définir les différentes courbes à ajouter, ou les opérations à

effectuer :

Figure I.28 : fenêtre d’ajout de courbes
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Remarque :

Il est possible de limiter le nombre de courbes listées en décochant les options non

souhaitées :

Analog grandeurs analogiques Currents Courants

Digital grandeurs logiques Alias Names Noms de Label

Voltages Tensions Subcircuit Nodes sous-circuits internes

La case « Trace expression » sert à indiquer le nom des grandeurs à visualiser, ainsi que les

fonctions mathématiques à réaliser. Il suffit de cliquer sur un élément de la zone « Variables »

ou de la zone « Fonctions ».

I-3-2-11-3) Ajout d’une fenêtre de visualisation de courbes :

Dans le cas où plusieurs courbes doivent être visualisées avec des échelles différentes,

il est nécessaire d’ajouter une ou plusieurs fenêtres de visualisation. Celles-ci peuvent être soit

sur le même écran, soit sur des écrans distincts.

 Ajout de fenêtre de visualisation sur le même écran :

Choisir l’option Plot→ Add Plot to Window : une fenêtre supplémentaire apparaît sur

le même écran (il est possible d’en avoir 3 simultanément).

Figure I.29 : fenêtre montrant la possibilité de visualiser plusieurs courbes sur le même

écran
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 Ajout de fenêtre de visualisation sur un nouvel écran :

Choisir l’option Window→ New Window : un nouvel écran de simulation apparaît.

Pour mentionner les nouvelles courbes à visualiser, il suffit de basculer, d’un écran à un autre

en cliquant sur l’onglet correspondant.

Onglet de la 2 ème visualisation

Onglet de 1 ère visualisation

Figure I.30 : fenêtre montrant la possibilité de visualiser des courbe sur un nouvel écran

I-3-2-11-4) Sauvegarde des paramètres de visualisation :

Dans certains cas, la visualisation des courbes nécessite diverses opérations pouvant être

fastidieuses :

 ajout de fenêtres de visualisation sur le même écran

 spécification d’échelles particulières

 ajout de courbes résultant des calculs...

Pour éviter d’avoir à redéfinir les paramètres de visualisation après chaque nouvelle

simulation, il est possible de:

 conserver les conditions de visualisation de la simulation précédente :

Cocher la case « Show - Last plot » dans l’onglet « Probe Window » du profil de simulation

(activé en cliquant sur l’icône de OrCad Capture ou l’icône de OrCad PSpice).
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Figure I.31 : enregistrement des resultats de simulation

 sauvegarder les conditions de visualisation en choisissant l’option Window→ Display

Control dans OrCad PSpice.

 donner un nom aux paramètres de visualisation, puis cliquer sur « Save », et enfin sur

« Close ».

Figure I.32 : nommer les paramètres de visualisation



Chapitre I                                                                                                                    Initiation au Pspice

48

La restitution des paramètres de visualisation s’effectue en choisissant l’option Window→

Display Control, puis en double cliquant sur le nom donné auparavant aux paramètres de

visualisation.

I-3-2-11-5) Utilisation des marqueurs :

La mesure de grandeurs à partir des courbes visualisées s’effectue en cliquant sur

l’icône

Le choix des curseurs s’effectue en sélectionnant le symbole associé à la courbe considérée

(et non le nom du signal). Un clic du bouton gauche, sélectionne le premier marqueur (A1).

Un clic du bouton droit, sélectionne le second marqueur (A2). Le déplacement des curseurs

s’effectue en maintenant le bouton de la souris appuyé et en le déplaçant

(bouton gauche :1er curseur ; bouton droit :2nd curseur).

Figure I.33 : fenêtre montrant l’utilisation d’un marqueur
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I-3-2-11-6) Ajout de commentaires :

Les courbes visualisées peuvent être commentées grâce à l’option du menu Plot→

Label .

Celle-ci permet de placer :

I-3-2-11-7) Impression / Exportation des résultats de simulation :

Pour imprimer les courbes visualisées à l’écran de simulation :

 sélectionner l’option File→ Print Preview, pour prévisualiser l’impression ;

 si le résultat de la prévisualisation n’est pas celui escompté, modifier la configuration

d’impression en choisissant l’option File→ Page Setup ;

 sélectionner ensuite l’option File→ Print, ou cliquer sur l’icône lorsque le résultat

de la prévisualisation est correct.

Il est possible d’exporter les résultats graphiques de la simulation (en vue de l’insérer

dans un traitement de texte par exemple), en choisissant l’option Window→ Copy to

clipboard, puis en cochant la case « Make window and plot backgrounds transparent ».

I-3-3) Simulation par l’éditeur de programme :

I-3-3-1) Lancement de Pspice AD Demo:

Pour écrire un programme d’un circuit électronique, on utilise Pspice AD Demo, pour

lancer le programme, il faut :

Soit cliquer sur l’icône :
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Soit aller dans le menu :

Démarrer→ Tous les programmes→ OrCAD Demo → Pspice AD Demo.

La fenêtre suivante s’ouvre :

Figure I.34 : la fenêtre de Pspice A/D Demo

I-3-3-2) Création d’un nouveau projet :

Pour l’ouverture d’un nouveau projet, cliquer sur la première icône de gauche , ou bien

faire :  File→ New→ Text File.

I-3-3-3) Syntaxe du fichier d’entrée (*.CIR) :
Le fichier d’entrée ou fichier de simulation est l’image du circuit à analyser. Le fichier de

simulation SPICE est composée d’un :

 Un titre,
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 Une "netlist" donnant une description topologique du circuit à analyser, à partir du

type et de la valeur des différents composants actifs et passifs et de leur

interconnexion,

 Un jeu de commandes pour fixer les analyses et le type de sortie à réaliser,

 Un jeu de directives de simulation,

 Un jeu de paramètres de contrôle,

 Un jeu de structures de données,

 Une indication de fin de fichier.

I-3-3-4) Ecriture d’un  programme en langage Spice :

 La première étape est de dessiner, au brouillon, son schéma.

 On attribue à chaque nœud, c'est-à-dire à chaque potentiel, un numéro arbitraire, (sauf

0 réservé pour la masse).

Remarque :

On peut avoir deux ou plusieurs nœuds similaires qui ont des positions différentes

dans un schéma, dans ce cas il est nécessaire d’attribuer à chaque ensemble de nœud similaire

le même numéro.

 On nomme chaque composant, en respectant son référence imposée.

 Puis on rédige le fichier.cir : il représente les liaisons entre composants et numéros de

nœud. Par exemple : « R2 1 2 1k » désigne une résistance nommée R2, insérée entre le

nœud 1 et nœud 2, de valeur 1kΩ.

Ce fichier .cir doit respecter une syntaxe, dont les principales règles sont :

La première ligne est obligatoirement le titre.

Les lignes commençant par le caractère "*" sont des commentaires.

Définition des sources : cette opération consiste à définir les différents signaux et sources

(de courant ou de tension) qui sont appliqués au circuit.

Vxx…

Ixx…

Description du circuit (Netlist) : chaque composant est décrit de manière à respecter la

syntaxe du langage SPICE.

Rxx …

Qxx…



Chapitre I                                                                                                                    Initiation au Pspice

52

Définition des modèles : dans le cas d’utilisation de composant simple tel que les résistances,

condensateurs et selfs il n’est pas obligatoire de spécifier le modèle utilisé (dans ce cas les

paramètres par défaut seront considérés), par contre dans le cas de composants plus complexe,

tel que les diodes, circuit intégré ou transistors on doit spécifier le nom du modèle utilisé pour

la simulation.

.model….

Dans le cas ou le composant utilisé se trouve dans Orcad (mais à condition qu’il soit

simulable), on utilise la commande {.lib eval.lib} qui télécharge automatiquement son

modèle.

Commandes de simulation : à ce stade de la description, le circuit est prêt à être simulé. A

cet effet il est nécessaire de lui spécifier le type de simulation à lancer.

.TRAN

.DC

.AC

.OP

Activation de la commande de sauvegarde des résultats de simulation :

. PROBE

Fin de la description : la description d’un modèle doit obligatoirement se terminer par le mot

clé «.END».

À noter également que le langage Spice est de format libre, c'est-à-dire que le texte d’une

ligne peut se poursuivre sur la ligne suivante, à condition qu’on s’inscrive un « + » au début

de cette ligne.

I-3-3-5) Syntaxe du langage pspice:
Resistance : Rxx   <nœud +>   <nœud->   <valeur>.

Capacité :    Cxx   < nœud +>  <nœud->   <valeur>.

Inductance : Lxx   < nœud +>   <nœud->  <valeur>.

Avec :    <Noeud+> et <Noeud-> = Noeuds de connexion.
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Transformateur :

Lp  Np1  Np2  <L1>

Ls  Ns1  Ns2  <L2>

Kxx  Lp  Ls   <valeur>

Avec : Np1,Np2 et Ns1, Ns2 :sont les nœuds de connexion de Lp et Ls respectivement.

<valeur> :coefficient de couplage

Pour les valeur <L1> et <L2>, on doit les calculer, pour cela il faut d’abord calculer le rapport

de transformation (a), puis on pose une valeur pour L1, et on déduit l’autre :

Ou : N1 et N2 représente le nombre de tours des enroulements primaire et secondaire du

transformateur.

Ligne de transmission :

Txx  N1 N2  N3  N4  <Z0=valeur>  <TD=valeur>

Avec : N1et N2 représentent les nœuds au port 1,

N3 et N4 désignent quant à eux les nœuds au port 2,

Z0 représente l’impédance caractéristique de la ligne de transmission,

TD : le délai de propagation.

Diode : Dxx  <Noeud+>   <Noeud->  <Modèle >.

avec :  <Noeud+> = Anode ;

<Noeud-> = Cathode ;
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<Modèle > = Modèle employé.

Transistor Bipolaire : Qxx <C> <B> <E> <Modèle>

avec : <C> = Collecteur ;

<B> = Base ;

<E> = Emetteur ;

<Modèle > = Modèle employé.

Transistor JFET : Jxx <D > <G> <S> <Modèle>

avec : <D> = Drain ;

<G> = Grille ;

<S> = Source.

Transistor MOS : Mxx <D> <G> <S> <B> <Modèle>

avec : <D> = Drain ;

<G> = Grille ;

<S> = Source ;

<B> = Substrat (Bulk).

Transformée de Laplace : Exx <Noeud+> <Noeud-> laplace  {V(Noeud+)}  {Expression}

Avec : <Noeud+> <Noeud->=Nœuds de connexion

{Expression} : c’est la fonction de transfert en s

Source continue : Source employée pour l’analyse continue (DC)

Courant : Ixx <Noeud+> <Noeud-> DC <Valeur>

Tension : Vxx <Noeud+> <Noeud-> DC <Valeur>

où   Valeur = Valeur de la tension continue appliquée entre les noeuds Noeud+ et Noeud- ou

Valeur du courant continu traversant la branche située entre les noeuds Noeud+ et Noeud-.

Source Alternative : Source employée pour l’analyse fréquentielle (AC)

Courant : Ixx <Noeud+> <Noeud-> AC <Amplitude> <Phase>

Tension : Vxx <Noeud+> <Noeud-> AC <Amplitude> <Phase>
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Où   Amplitude = Valeur de la tension alternative appliquée entre les nœuds Noeud+ et

Noeud- ou Valeur du courant alternatif traversant la branche située entre les noeuds Noeud+

et Noeud- ; Phase = Déphasage initial (en degré, 0 par défaut).

Signaux Périodiques : Source employée pour l’analyse temporelle

PWL : Nuage de Points, segments fonction du temps.

PWL(<T1>, <Val1>) ( <T2>, < Val 2>) … (<Tx>, < Val x>)

Avec : Tx = Instant Tx ;

Valx = Valeur (tension ou courant) à l’instant Tx.

Courant : Ixx <Noeud+> <Noeud-> PWL(…)

Tension : Vxx <Noeud+> <Noeud-> PWL(…)

PULSE : Impulsion avec un niveau haut et un niveau bas, définies par différents temps.

PULSE( <ValInit> <ValImp> <TpsRet> <TpsMont> <TpsChute> <TpsImp> <TpsPer>)

Avec : ValInit = Valeur initiale (Etat « OFF ») ;

ValImp = Valeur de l’impulsion (Etat « ON ») ;

TpsRet = Retard de début d’impulsion (0 par défaut) ;

TpsMont = Temps de montée (toujours supérieur à 0, Tstep par défaut) ;

TpsChute = Temps de descente (toujours supérieur à 0, Tstep par défaut) ;

TpsImp = Largeur de l’impulsion (Tstop par défaut) ;

TpsPer = Période (Tstop par défaut).

Courant : Ixx <Noeud+> <Noeud-> PULSE(…)

Tension : Vxx <Noeud+> <Noeud-> PULSE(…)

SIN : Sinusoïde d’amplitude constante ou amortie.

SIN(<ValOffset> <ValAmpl> <Frq> <TpsRet> <FactAmort> <Phase>)

Avec : ValOffset = Valeur continue ;

ValAmpl = Amplitude de la sinusoïde ;

Frq = Fréquence du signal sinusoïdal (1/Tstop par défaut) ;

TpsRet = Retard du début d’amortissement ;

FactAmort = Facteur d’amortissement ;

Phase = Déphasage initial (en degré).
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source logique :

U<name> STIM(<width>, <format array>)

+ <digital power node> <digital ground node>

+ <node>*

+ <I/O model name>

+ [IO_LEVEL=<interface subckt select value>]

+ <command>*

Avec : Width: indique le nombre de signaux (nœuds) de sortie par le générateur de stimulus.

Format array : spécifie le format utilisé dans la définition du stimulus.

Digital power node et digital ground node : ces nœuds sont utilisés par les dispositifs

d’interface qui relient les nœuds analogiques aux nœuds numériques ou vice versa.

Node : le nœud de sortie par le générateur de stimulus.

I/0 model name : le modèle I/0 nommé IO-STM décrit les caractéristiques de conduite

du générateur de stimulus.

I0_LEVEL : ce paramètre est à 0 par défaut dans le cas ou aucun nœud n’est connecté

à un périphérique analogique.

Command : une description des stimuli, en utilisant l’élément suivant : « temps »

« valeur ».

N.B : dans le cas ou le nombre de commande <temps> <valeur> est important, c’est plus

pratique d’utiliser la syntaxe suivante :

+Repeat forever  +<temps> <valeur>  +<temps> <valeur>  END Repeat

Sachant que : Repeat forever c'est-à-dire : répétition sans cesse

END Repeat : fin de répétition

Remarque :

Il existe d’autres commandes pour la génération des signaux logiques, mais elles ne sont pas

mentionnées ici, car on a définit uniquement celles utilisées dans les exemples à venir.
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I-3-3-6) Simulation sous Pspice :

I-3-3-6-1) Simulation en régime continu :

Le régime continu correspond à un signal indépendant du temps. Seules les sources

DC sont alors considérées, les autres sources sont ignorées. Les sources de courant non

continues sont alors des circuits ouverts (idéalement, leur impédance est infinie) et les sources

de tensions non continues deviennent des courts-circuits (impédance idéalement nulle).

Différentes commandes sont disponibles en fonction de ce que l’on veut visualiser :

.OP : Analyse du point de fonctionnement (I0 – V0).

Syntaxe : L’appel de la commande dans le fichier d’entrée est simplement :

.OP. Elle ne requière aucun argument supplémentaire ou définition de grandeur de sortie

.DC : Analyse de balayage en continu.

Syntaxe :

.DC <Loi_Var> <Variable> <Valeur_Deb> <Valeur_Fin> <Pas>

Avec : Loi_Var = Mode de variation du paramètre (LIN, DEC ou OCT) ;

Variable = Nom du paramètre variant ;

Valeur_Deb = Valeur initiale du paramètre ;

Valeur_Fin = Valeur final du paramètre ;

Pas = Pas de variation.

I-3-3-6-2) Simulation dans le domaine fréquentiel (ou harmonique) :

.AC : Analyse fréquentielle

Par ce type d’analyse, il est possible d’obtenir un certain nombre de paramètres de

performance du circuit des plus pertinents.

Syntaxe : .AC <Loi_Var> <Nb_Points> <Frq_Deb> <Frq_Fin>

Avec : Loi_Var = Loi de variation (LIN, DEC ou OCT) ;

Nb_Points = Nombre de points par unité de variation ;

Frq_Deb = Fréquence de début d’analyse ;

Frq_Fin = Fréquence de fin d’analyse.
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I-3-3-6-3) Simulation dans le domaine temporel :

.TRAN : Analyse transitoire (TRANSCIENT sous Windows)

Syntaxe : .TRAN <Pas_Max > <Durée_Ana>

Avec : Pas_Max = Pas de génération des résultats ;

Durée_Analyse = Dimension de la fenêtre de simulation.

I-3-3-6-4) Simulations complémentaires :

I-3-3-6-4-1) Les Conditions Initiales :

Cette simulation permet d’imposer un potentiel à un nœud en début de simulation par

l’intermédiaire de certains composants tels que les capacités, les inductances et les lignes de

transmission. On lève ainsi toute ambiguïté sur l’état de ce nœud, mais elle permet aussi de

définir le point de fonctionnement d’un système dans des temps de calcul plus réduits lors de

simulations multiples et de régler d’éventuels problèmes de convergence. Ces définitions ne

sont permises qu’en tension d’une façon relative entre deux nœuds ou d’une façon absolue

entre le nœud et la masse. La commande .IC est la plus employée mais la commande

.NODESET est tout aussi possible (la différence étant que .NODESET ne force pas de

niveaux. Elle ne sert qu’à indiquer une valeur initiale préalable à la recherche du point de

fonctionnement).

Syntaxe : .IC V<Noeud(s)> = <Valeur>

Remarque : si vous utilisez des bascules ou des compteurs, il faudra penser à initialiser toutes

les bascules à 0 on utilisant la commande .OPTION.

Syntaxe : .OPTION DIGINITSTATE=0

I-3-3-6-4-2) Simulations multiples :

Par simulations multiples, on entend effectuer plusieurs fois la même simulation en

faisant

varier la valeur d’un paramètre, d’une variable (température, tension d’un nœud, ou

paramètre du modèle, …).

Syntaxe : .STEP <LoiVar> <Var> <ValDebut> <ValFin> <Pas>

Avec : Loi_Var = Loi de variation de la variable.

Var = Variable ;

ValDebut = Valeur de début de la variable ;
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ValFin = Valeur de fin de la variable ;

Pas = Pas de simulation

L’utilisation des variables s’effectue par l’emploi de la commande .PARAM. Elles sont

alors utilisées entre accolades ({Nom_Var}). Par défaut, la température TEMP et le temps

TIME sont deux variables internes au système.

Syntaxe : .PARAM <Var> = <Valeur>

.STEP PARAM <Var> <Loi_Var>

Où : Var = Variable dont on fait varier la valeur ;

Valeur = Valeur initiale de la variable ;

Loi_Var = Loi de variation de la variable

Remarque :

Il existe d’autres commandes dans le Pspice, qu’on n’a pas mentionnées ici, car on a

définit uniquement celles utilisées dans les exemples à venir.

I-3-3-7) Ouvrir un projet existant :

Pour ouvrir un projet existant, ou le chercher, sélectionner l’icône ou bien faire :

File→ Open...

Une fenêtre s’ouvre :

Figure (I.35) : Ouverture d’un fichier .CIR

 Dans le champ « chercher », naviguer pour accéder au répertoire désiré,

 Dans le champ « Fichiers de type », sélectionner la ligne « Circuit files (*.cir) »,

 Ainsi que dans le champ « Open as » : valider « Auto ».
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 Une liste de fichier.cir apparait. Choisir celui correspondant à la simulation que l’on

veut refaire, et quand son nom apparait dans le champ « Nom », cliquer sur l’icône

« ouvrir ».

 Dans le menu déroulant « simulation », cliquer « Run ».

 En fin de simulation, dans le menu déroulant « trace », cliquer « Add Trace » : une

liste des potentiels apparait. Cliquer sur la variable à visualiser.

Remarques :

1. Il est possible de télécharger une version d'évaluation PSPICE STUDENT sur différents

sites internet dont :

http://www.engr.uky.edu/~cathey/pspice061301.html

2. Pour l’importation des modèles, nous pouvons trouver une grosse banque de données

concernant les modèles SPICE sur le site :

http://www.cadence.com/products/si_pk_bd/downloads/pspice_modèles/index.aspx.

Les modèles SPICE sont généralement fournis sous forme de fichier texte (.LIB), et plus

rarement avec la librairie de symbole (.OLB) correspondant.

La procédure de téléchargement des librairies.LIB sur internet est la suivante :

On tape sur Google « elantec.LIB » et on clique sur :

Index of/≈ Krausg/Spice_Model_CD/Mixed Part List/Spice-Models-Collection, on obtient

ainsi plus de 80 librairies.LIB à télécharger.

I-4) Discussion :
Le but de cette initiation à Pspice ne prétend pas décrire toutes les fonctionnalités (réalisation

des circuits logiques programmables sous VHDL, réalisation d’analyses complexes Monte-

Carlo, etc.). Il faudrait tripler le nombre de pages. L’objectif est de permettre, dans un premier

temps, de maitriser l’outil, ainsi que le langage spice.

http://www.engr.uky.edu/~cathey/pspice061301.html
http://www.cadence.com/products/si_pk_bd/downloads/pspice_mod�les/index.aspx
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II-1) Préambule :
Pour simuler le fonctionnement de circuits électroniques analogiques, numériques ou

mixtes, nous allons utiliser PSPICE, un logiciel mondialement connu pour ce genre

d’applications. D’une utilisation très conviviale, il permet d’accéder rapidement au résultat

souhaité en construisant le circuit électronique désiré.

II-2) Application du PSPICE à la pédagogie :
Notre objectif est de nous initier avec le logiciel de simulation PSPICE afin de

connaitre l’architecture de base de ce logiciel et de pouvoir aisément simuler les circuits de

base étudiés dans les différents modules. Nous serons donc amener à comparer les résultats

obtenus par simulation aux résultats obtenus théoriquement et dans les séances de TP.

La simulation de circuit électronique peut s’effectuer en deux méthodes :

Soit décrire le circuit dans un fichier texte (*.CIR) sous forme d’un programme ou bien le

saisir en utilisant l’éditeur de schéma.

II-2-1) Application au module d’électronique générale (TEC580) :
II-2-1-1) Redressement simple alternance :

II-2-1-1-1) Simulation à partir de l’éditeur schéma :

II-2-1-1-1-1) Création d’un nouveau projet :

Commençons par ouvrir l’application Orcad Capture.

Nous allons maintenant créer un nouveau projet :

File → New → Project

Figure II.1 : procédure de création d’un nouveau projet

On nomme notre  projet (Name) en  précisant le répertoire ou il sera enregistré (Location).
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On coche l’option Analog or Mixed A/D.

Figure II.2 : fenêtre de création de projet

On coche l’option Create a blank project (projet vierge).

Figure II.3: fenêtre de création de projet existant/non existant
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II-2-1-1-1-2) Saisie du schéma électrique avec l’application OrCAD Capture :

Le gestionnaire de projet apparait :

Figure II.4 : fenêtre de gestionnaire de projet

Dans le gestionnaire de projet, double cliquant sur PAGE1 pour éditer la fenêtre

SCHEMATIC1 : PAGE1.

C’est dans cette fenêtre que sera saisi le schéma électrique.

Figure II.5 : fenêtre principale de l’éditeur Capture
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La palette d’outils (View → Tool Palette) apparait également :

Figure II.6 : palette d’outils

a) Placement des composants du circuit :

Commençons par placer la résistance :

Place → Part ou appuyant sur la touche p, ou cliquant sur l’icône suivante de la palette

d’outils :

Figure II.7 : sélection de l’icône Place Part dans la palette d’outils

La fenêtre Place Part apparait :

Figure II.8 : fenêtre de sélection des composants

On clique sur Add library (ajouter une librairie).

On ouvre la librairie analog.olb
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Figure II.9 : fenêtre de sélection des librairies

Dans cette librairie, on sélectionne la résistance R :

Figure II.10 : visualisation d’une résistance dans la fenêtre Place Part

Il ne reste plus qu’à placer avec la souris, la résistance dans la fenêtre SCHEMATIC1 :

PAGE1
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Par défaut, la résistance vaut 1000 ohms.

Double cliquant sur la zone « 1K ».

La fenêtre Display Properties apparait.

On modifie la valeur de la résistance (10 K ohms) :

Figure II.11 : changement de la valeur de la résistance

On fait un clic gauche sur le corps de la résistance, on clique à droite et on sélectionne Rotate

(rotation) ou bien :

Edit → Rotate, ou plus simplement appuyant sur la touche r :

De la même manière, on place la diode (D1N4002) et la source de tension sinusoïdale

(amplitude crête de 10V, fréquence de 1kHZ).
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Symbole Librairie

R Analog.olb

D1N4002 Eval.olb

VSIN Source.olb

Figure II.12 : librairies associés aux composants utilisés dans l’exemple

Figure II.13 : placement des composants et de la source

Sauvegardant notre projet (File → Save).

b) Placement de la masse (0 V) :

Place → Ground, ou appuyant sur la touche g, ou bien cliquant sur l’icône suivante de la

palette d’outils :

Figure II.14 : sélection de l’icône Place Ground dans la palette d’outils

.

Figure II.15 : librairie associé à la masse 0

Symbole Librairie

0 Source.olb
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La fenêtre Place Ground apparait.

Figure II.16 : sélection de la masse

Figure II.17 : placement de la masse

c) Placement des fils de connexion et des nœuds (junctions) :

Pour placer un fil :

Place → Wire, ou appuyant sur la touche w, ou bien cliquant sur l’icône suivante de la palette

d’outils :

Figure II.18 : sélection de l’icône Place Wire dans la palette d’outils

Le curseur de la souris prend la forme d’une croix.

Pour placer ou supprimer un nœud :



Chapitre II                                                                                                 Application du Pspice à la pédagogie

69

Place → Junction, ou appuyant sur la touche j, ou bien cliquant sur l’icône suivante :

Le curseur de la souris prend la forme d’un nœud.

Il ne reste plus qu’à compléter le schéma.

Finalement :

Figure II.19 : saisie de schéma dans l’éditeur Orcad Capture

II-2-1-1-1-3) Simulation avec l’application Pspice A/D :

Pour pouvoir être simulé, un composant doit posséder un « modèle PSpice ».

On le vérifie avec la présence d’une icône en bas à droite :

Modèle PSpice

Figure II.20 : vérification de présence du modèle Pspice de la diode D1N4002
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a) Nouvelle simulation :

Pspice → New Simulation Profile

Figure II.21 : fenêtre de création d’un profil de simulation

PSpice → Edit Simulation Profile

La fenêtre Simulation Settings s’ouvre.

Nous allons faire une analyse temporelle du circuit dans l’intervalle 0 à 5 ms avec un pas de

1ms.

Figure II.22 : fenêtre de configuration de redressement simple alternance.opj
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b) Placement des sondes (markers) :

Pour placer une sonde de potentiel :

PSpice → Markers → Voltage Level

Figure II.23 : placement des sondes

On peut également utiliser les icones :

PSpice → Run

L’application Pspice A/D s’ouvre et donne les résultats suivants :

Figure II.24 : résultat de simulation
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Pour une simulation plus fine, il faut ajuster le pas de calcul (Maximum step size).

Essayons avec 10us :

Simulation → Edit Profile

Figure II.25 : changement du pas de calcul dans la fenêtre de configuration

Simulation → Run

La sinusoïde ressemble à une vraie sinusoide, ce qui n’était pas tout à fait le cas dans la

simulation précédente :
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Figure II.26 : les résultats de simulation

Remarque :

Pour avoir une meilleure finesse des résultats sur l’écran, on choisit le pas de calcul de

T stop/1000  à T stop/100.

T stop : temps de fin de simulation

Maintenant on peut zoomer :

View → Zoom

Figure II.27 : le zoom des courbes obtenues
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II-2-1-1-2) Simulation à partir d’un fichier d’entrée.CIR :

1- Commençant par ouvrir l’application PSpice AD

2- Nous  allons maintenant lancer l’éditeur de texte :

Cliquant sur l’onglet ou bien faire, File → New → Text file

Figure II.28 : procédure de lancement d’éditeur de texte

3- On saisit la description du circuit à simuler.

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.29 : localisation et numérotation des nœuds

1. Numérotation des nœuds du circuit : avant de commencer la description SPICE du circuit,

il faut au préalable localiser tous les nœuds du circuit, puis attribuer à chaque nœud un

numéro qui permettra de le localiser.

2. Description des composants : chaque composant est décrit de manière à respecter la syntaxe

du langage SPICE. Les connexions de chaque composant du circuit sont localisées par les

numéros attribués précédemment.
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Redressement simple alternance → titre de la description (obligatoire au début du

programme).

D1    1    2 D1N4002 → description de la diode

R1    2    0 10K → description de la résistance

3. Définition des sources : après avoir décrit le circuit en connectant ses différents composants,

l’opération suivante consiste à définir les différents signaux et sources (de courant ou de

tension) qui sont appliqués au circuit. Dans cet exemple :

V1  1  0  SIN ( 0  10  1K  0  0  0 ) → application d’un signal sinusoïdal V1 entre les

nœuds 1 et 0 du circuit.

4. Modélisation des composants : dans le cas des composants complexes tels que les diodes,

les transistors et les amplificateurs…etc. On doit introduire les caractéristiques du modèle

utilisé pour la simulation. Dans cet exemple, la diode utilisée à pour modèle : D1N4002.

.MODEL D1N4002 D (IS=14.11E-9  N=1.984  RS=33.89E-3 IKF=94.81  XTI=3

+ EG=1.110  CJO=51.17E-12  M=.2762  VJ=.3905  FC=.5  ISR=100.0E-12

+ NR=2  BV=100.1  IBV=10  TT=4.761E-6) → définition du modèle de la diode

D1 utilisé pour  la simulation.

Remarque :

Dans le cas ou le modèle se trouve dans la  librairie EVAL, il suffit d’écrire la

commande suivante : « .LIB EVAL.lib » pour charger ses caractéristiques automatiquement.

5. Contrôle de la simulation : à ce stade de la description, le circuit est prêt à être simulé. A cet

effet, il est nécessaire de lui spécifier le type de simulation à lancer. Dans notre cas c’est

l’analyse transitoire ou temporelle.

.TRAN  10u  5m → activation de l’analyse transitoire.

6. Activation de la commande de sauvegarde des résultats de simulation :

.PROBE → activation de la commande de sauvegarde des résultats de la simulation.

7. Fin de la description : la description d’un modèle doit obligatoirement se terminer par le mot

clé « .END ».

.END → fin de la description.
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Figure II.30 : saisie du programme dans l’éditeur de texte

4-On nomme notre fichier, puis on le sauvegarde à l’endroit qu’il faut avec l’extension.CIR
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Figure II.31 : enregistrement du fichier avec l’extension .cir

5-Chargeant le fichier.CIR qu’on vient de créer :

File → open

Figure II.32 : procédure de chargement du fichier .cir
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Figure II.33 : activation de la simulation

La simulation de notre circuit est alors lancée.
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Figure II.34 : fin de simulation par l’activation de l’icône Probe

Visualisant les résultats de notre simulation en cliquant sur l’icône View Simulation Results

Faire Trace → Add trace.
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Figure (II.35) : procédure de visualisation des résultats de simulation

On sélectionne dans la liste de gauche les variables qu’on désire observer.

Dans  cet exemple, on visualise les tensions aux nœuds 1 et 2 (V1 et V2).

Figure (II.36) : fenêtre ajout des traces
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Le module PROBE donne les résultats suivants :

Figure II.37 : les résultats de simulation

II-2-1-1-3) Interprétation des résultats :

Le principe du redressement simple alternance est basé sur les propriétés des diodes. En

effet la diode se bloquant lorsque la tension à ses bornes est négative, elle supprime las

alternances négatives du signal d’entrée. Pendant les alternances positives, elle se comporte

comme un court circuit et n’altère donc pas le signal d’entrée.
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II-2-1-2) Redressement double alternance :
II-2-1-2-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.38 : saisie de schéma sous Orcad Capture

 Configuration :

On désire effectuer une analyse temporelle, ce qui signifie qu’on veut observer la

variation de la tension en fonction du temps aux nœuds marqués.

Après création d’un nouveau profil, on choisit l’option Time Domain (Transient) dans

Analysis type, dont la durée de simulation est de 60ms et le pas de calcul est de 0.01ms,

comme le montre la boite de dialogue de l’option new simulation profile du menu Pspice.
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Figure II.39 : fenêtre de configuration du redressement double alternance.opj

 Simulation :

Le circuit est alors prêt à être simulé. Cliquant sur pspice → Run , ou bien sur l’icône .

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne le

graphique suivant :

Figure II.40 : visualisation des résultats sous Probe

Time
0s 10ms 20ms 30ms 40ms 50ms 60ms

V(SORTIE) V(V1:+)
-40V

0V

40V
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II-2-1-2-2) Simulation à partir d’un fichier d’entrée.cir:

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.41 : localisation et numérotation des nœuds

 On Saisit la description du circuit en langage Spice dans l’éditeur de texte :

Redressement double alternance

*description du circuit

R3 1 2 0.3m

R2 0 5 100meg

R1 5 6 150

D1 4 6 D1N4002

D2 3 6 D1N4002

D3 5 4 D1N4002

D4 5 3 D1N4002

L1 2 0 0.1

L2 3 4 0.1

Kt L1 L2 1

.MODEL D1N4002 D (IS=14.11E-9  N=1.984  RS=33.89E-3  IKF=94.81  XTI=3

+ EG=1.110  CJO=51.17E-12  M=.2762  VJ=.3905  FC=.5  ISR=100.0E-12

+ NR=2  BV=100.1  IBV=10  TT=4.761E-6)

*définition des sources

V1 1 0 sin(0 34 50 0 0 0)
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.TRAN 0.01m 60m

.PROBE

.END

 On nomme le fichier « redressement double alternance.cir » puis on le sauvegarde à

l’endroit qu’il faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.42 : visualisation des résultats sous Probe

II-2-1-2-3) Interprétation des résultats :

En associant 4 diodes dans un montage en pont, il est possible de faire un redresseur

double alternance. Seules les diodes pour lesquelles la tension d’anode dépasse la tension de

cathode de la tension de seuil sont conductrices. D2 et D3 conduisent quand V1, la tension

d’entrée, est positive.les diodes D1 et D4 conduisent quand V1 est négative.

Time
0s 10ms 20ms 30ms 40ms 50ms 60ms

V(1) V(6)
-40V

0V

40V
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II-2-1-3) Pont de diode :

II-2-1-3-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Pspice :

Figure II.48 : saisie de schéma sous Orcad Capture

 Configuration :

Après création d’un nouveau profil de simulation, on effectue une analyse temporelle de

durée de 100ms avec un pas de 1us, comme indiqué sur la figure suivante :

Figure II.49 : fenêtre de configuration de pont de diode.opj
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 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur pspice → Run ,ou bien sur l’icône .

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne le

graphique suivant :

Figure II.50 : visualisation des résultats sous Probe

II-2-1-3-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.51 : localisation et numérotation des nœuds

Time
0s 20ms 40ms 60ms 80ms 100ms

V(D1:2) V(V1:+,D2:1)
-10V

0V

10V
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 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

pont de diode

D1 2 3 D1N4002

D2 1 3 D1N4002

D3 0 1 D1N4002

D4 0 2 D1N4002

C1 0 3 3300U

R1 0 3 47

*définition des sources

V1 2 1 SIN(0 10 50)

.LIB EVAL.LIB

.TRAN 5U 100ms

.PROBE

.END

 On nomme le fichier « pont de diode.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.52 : visualisation des résultats sous Probe

II-2-1-3-3) Interprétation des résultats :

Le filtrage de la tension (de sortie) est fait à l’aide d’un condensateur de valeur 3300uF,

on a une tension de sortie presque continue et dont la valeur se rapproche de la tension

efficace du générateur (la sinusoïde est la mesure de la tension aux bornes du générateur). En
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règle générale, lorsque le redresseur alimente une charge résistive de résistance R, plus le

produit RC est grand, plus le filtrage est efficace.

II-2-1-4) Analyse avec un paramètre :

II-2-1-4-1) Simulation à partir de l’éditeur schéma :

Dans certains cas, il est intéressant de faire varier un paramètre afin d’étudier son

influence. Nous allons voir à travers un exemple simple comment cela est possible.

 Dessin de schéma sous  OrCAD Capture :

Figure II.53 : saisie de schéma sous Orcad Capture

En fixant la valeur de R2={Rvar} , cela permet de la déclarer comme étant variable.

Double cliquant sur le texte «parameters » et appuyant sur le bouton « New », on obtient

ainsi la fenêtre suivante :

Figure II.54 : ajout d’une nouvelle variable en spécifiant son nom et sa valeur

On introduit un nom et une valeur à la variable R2.

Remarque :

La valeur 1k de Rvar est prise par défaut.
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En validant, on obtient ainsi la nouvelle colonne, comme indiqué sur la figure suivante :

Figure (II.55) : éditeur de propriétés du bloc PARAM

On sélectionne la colonne Rvar puis on  clique sur « Display… ».

 Configuration :

Après création d’un nouveau profil, on choisit l’option AC Sweep dans Analysis type, puis on

coche sur « Global parameter », dont on choisit  de faire varier la résistance Rvar de 50Ω à

20kΩ par pas de 10Ω, comme le montre la boite de dialogue de l’option new simulation

profile du menu Pspice.

Figure II.56 : fenêtre de configuration du paramètre choisi

 Simulation :

Cliquant sur pspice → Run, ou bien sur l’icône

Par la suite, Pspice AD démarre automatiquement. On clique sur la touche « inser » puis on

tape : V (sortie)*V (sortie)/Rvar (la puissance dissipée dans la résistance de sortie), après

validation on obtient la courbe suivante :
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Figure II.57 : visualisation du résultat sous Probe

II-2-1-4-2) Simulation à partir d’un fichier d’entrée .cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.58 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

analyse param

*description des composants

R1 1 2 1K

R2 2 0 {Rvar}

*définition des sources

V1 1 0 10V

.PARAM Rvar 1K

.DC LIN PARAM Rvar 50 20K 10

.PROBE

.END

 On nomme le fichier « Analyse param.cir » puis on le sauvegarde à l’endroit qu’il faut.

Rvar
0 5K 10K 15K 20K
V(sortie) * V(sortie) / Rvar

0

10m

20m

30m
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 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.59 : visualisation du résultat sous Probe

II-2-1-5) Tracé d’une caractéristique d’un transistor :

II-2-1-5-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous  OrCAD Capture :

Figure II.60 : saisie de schéma sous Orcad Capture

Pour déclarer la résistance R2 comme étant une résistance variable, on doit refaire les mêmes

étapes que l’exemple précédent.

 Configuration :

Après création d’un nouveau profil, on choisit l’option AC Sweep dans Analysis type, dont on

définie  les paramètres d’une analyse continue, comme indiqué sur la fenêtre suivante :

Rvar
0 5K 10K 15K 20K
V(2) * V(2) / Rvar

0

10m

20m

30m
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Figure II.61 : fenêtre de configuration de tracé d’une caractéristique d’un

transistor.opj

Puis on coche « Parametric Sweep » et on définit les paramètres de cette analyse comme

indiqués sur la fenêtre suivante :

Figure II.62 : fenêtre de configuration parametric sweep de tracé d’une

caractéristique d’un transistor.opj

 Simulation :

Le circuit est alors prêt à être simulé.



Chapitre II                                                                                                 Application du Pspice à la pédagogie

94

Cliquant sur pspice → Run, ou bien sur l’icône

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne le

graphique suivant :

Figure II.63 : les résultats de simulation

On sélectionne une courbe directement dans la fenêtre de visualisation, et on choisit dans le

menu contextuel l’option « Information ».

Une fenêtre affiche les conditions particulières de simulation pour cette courbe (ici Rbvar =

61 KHz)

Figure II.64 : visualisation de la valeur du paramètre sur la courbe sélectionnée

V_V2
0V 1.0V 2.0V 3.0V 4.0V

V(Q1:c)
0V

2.5V

5.0V
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II-2-1-5-2) Simulation à partir d’un fichier d’entrée .cir :

Le paramètre dans ce cas, est la valeur de la résistance de base.

Le circuit à modéliser est représenté sur la figure suivante :

Figure (II.65) : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Analyse parametrique

*Description des composants

R1 3 4 1K

R2 1 2 {Rbvar}

Q1 3 2 0 Q2N2222

*Definition des sources

vcc 4 0 5V

V2 1 0 0V

.LIB EVAL.LIB

.PARAM Rbvar 1K

.DC LIN V2 0 3.5V 0.05V

.STEP PARAM Rbvar 1K 101K 20K

.PROBE

.END

 On nomme le fichier « Analyse paramétrique.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.
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 Le module PROBE donne les résultats suivants :

Figure II.66 : les résultats de simulation

II-2-2) Application au module d’asservissement (Tec 579) :
II-2-2-1) Filtre passe-bas passif RC :

II-2-2-1-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous  OrCAD Capture :

Figure II.67 : saisie de schéma sous Orcad Capture

 Configuration :

On désire effectuer une analyse fréquentielle, ce qui signifie qu’on veut observer la

variation de la tension en fonction du la fréquence.

Après création d’un nouveau profil, on choisit l’option AC Sweep/Noise dans Analysis

type, dont on choisit le balayage logarithmique et les paramètres suivants, comme indiqués

sur la boite de dialogue de l’option new simulation profile du menu Pspice.

V2
0V 1.0V 2.0V 3.0V 4.0V

V(3)
0V

2.5V

5.0V
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Figure II.68 : fenêtre de configuration du filtre passe-bas passif.opj

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur pspice → Run, ou bien sur l’icône ; la fenêtre des résultats s’ouvre

et donne directement le diagramme de Bode du gain (en décibels).

Pour ajouter le diagramme de Bode de la phase on clique sur Plot→Add Plot to

Window, une autre fenêtre apparait, ensuite on fait  Trace→Add trace et on choisit

p(V(sortie)).
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Les résultats obtenus sont les suivants :

Figure II.69 : visualisation des résultats sous Probe

II-2-2-1-2) Simulation à partir d’un fichier d’entrée .cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.70 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Filtre passe bas

*description du circuit

R1 1 2 10K

C1 2 0 10n

*définition des sources

V1 0 1 AC 1V

.AC DEC 1000 10 100000

.PROBE

.END

Frequency
10Hz 100Hz 1.0KHz 10KHz 100KHz

VDB(SORTIE)
-40

-20

0

SEL>>

P(V(sortie))
-100d

-50d

0d
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 On nomme le fichier « filtre passe-bas.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.71 : les résultats de simulation

II-2-2-1-3) Interprétation des résultats :

Le filtre passe-bas est un dispositif qui démontre une réponse en fréquence

relativement constante (gain fixe) aux basses fréquences, et un gain décroissant aux

fréquences supérieurs à la fréquence de coupure fc, sachant que fc = ou wc = .

Pour notre montage la fréquence de coupure à trouver est : fc = 1600 Hz.

Les mesures nous donnent 1.6kHz comme fréquence de coupure à -3dB. La bande passante

vaut aussi 1.6kHz. Ces valeurs sont conformes à la valeur théorique calculée.

II-2-2-2) Réponse indicielle d’un circuit RLC :

II-2-2-2-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous  OrCAD Capture :

Figure (II.72) : saisie de schéma sous Orcad Capture

Frequency
10Hz 100Hz 1.0KHz 10KHz 100KHz

DB(V(2))
-40

-20

0

SEL>>

diagramme de Bode: Gain

P(V(2))
-100d

-50d

0d

diagramme de Bode: phase
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 Configuration :

On désire effectuer une analyse temporelle, ce qui signifie qu’on veut observer la variation

de la tension en fonction du temps.

Après création d’un nouveau profil de simulation, on effectue une analyse temporelle de

durée de 2ms avec un pas de 10 ns, comme indiqué sur la figure suivante :

Figure II.73 : fenêtre de configuration de réponse indicielle du circuit RLC.cir

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur pspice → Run, ou bien sur l’icône
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Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne directement

la figure suivante : V(C1 :2)

Figure II.74 : visualisation du résultat sous Probe

II-2-2-2-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.75 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :
réponse indicielle d’un circuit RLC

*description des composants

R1 1 2 100

L1 2 3 20m

C1 3 0 1u

.IC V(3)=0

*définition des sourceS

V1 1 0 10V

.TRAN  0 2m 0 10n SKIPBP

.PROBE

.END

Time
0s 0.5ms 1.0ms 1.5ms 2.0ms

V(C1:2)
0V

5V

10V

15V
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 On nomme le fichier « réponse indicielle RLC.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit

 Le module PROBE donne les résultats suivants :

Figure II.76 : le résultat de simulation

II-2-2-2-3) Commentaires :

On remarque que la valeur du premier dépassement (D1%) est de : 30%

Car 100% →   10V

D1% →     3V         donc D1% = × = 30%

Le temps ou il a lieu le dépassement D1 est  tpic = 0.47ms ce qui correspond au résultat

théorique : tpic = , = , = 0.47ms. Sachant que wn = √ = 7071 rd/s.

Time
0s 0.5ms 1.0ms 1.5ms 2.0ms

V(3)
0V

5V

10V

15V
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II-2-2-3) Filtre passe-haut actif à A.O. µA741 :

II-2-2-3-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous  OrCAD Capture :

Figure II.77 : saisie de schéma sous Orcad Capture

Remarque :

On ne peut pas Placer des sondes (VDB) avant de faire la simulation (simulation

fréquentielle).

Le placement de ces sondes se fait de la manière suivante :

Du menu Orcade capture, faire : PSpice -> Markers -> Advanced -> dB Magnitude of Voltage

 Configuration :

On désire effectuer une analyse fréquentielle, ce qui signifie qu’on veut observer la

variation de la tension en fonction de la fréquence.

Après création d’un nouveau profil, on choisit l’option AC Sweep/Noise dans Analysis

type, dont on choisit le balayage logarithmique, la fréquence de départ  10

Hz, la fréquence de fin 100000Hz, le nombre de points par décade 1000, comme indiqués

sur  la figure suivante :
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Figure II.78 : fenêtre de configuration du filtre passe-haut actif.cir

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur pspice → Run, ou bien sur l’icône

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne directement

le diagramme de Bode du gain (en décibels).

Et pour ajouter le diagramme de Bode de la phase, on clique sur Plot→Add Plot to Window,

une autre fenêtre apparait, on fait Trace→Add trace et on  choisit p(V(sortie)).

Les résultats obtenus sont les suivants :
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Figure II.79 : les résultats de simulation

Remarque :

Pour ajouter des commentaires sur le graphe, cliquant sur Plot→Label→Text ; la fenêtre

suivante apparait :

Figure II.80 : fenêtre d’ajout de commentaire sur le graphe

On saisit le titre puis on clique sur « Ok » et on le met à l’endroit  souhaité.

Frequency
10Hz 100Hz 1.0KHz 10KHz 100KHz

VDB(SORTIE)
-40

0

40
Diagramme de Bode: gain

P(V(sortie))
0d

50d

100d

SEL>>

Diagramme de Bode: phase
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II-2-2-3-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.81 : saisie de schéma sous Orcad Capture

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

filtre passe haut actif

*description du circuit

R1 0 3 2.2K

R2 3 6 19.8K

R3 2 0 10K

C1 1 2 10n

X 3 2 10 11 6 uA741

.LIB EVAL.LIB

*définition des sources

V1 1 0 AC 1 DC 0

Vplus 10 0 12V

Vmoins 11 0 -12V

.AC DEC 1000 10 100000

.PROBE

.END
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 On nomme le fichier « filtre passe-haut actif.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.82 : le résultat de simulation

Maintenant ajoutant le diagramme de Bode de la phase.

Figure (II.83) : visualisation des résultats sous Probe

Frequency
10Hz 100Hz 1.0KHz 10KHz 100KHz

DB(V(6))
-40

-20

0

20

Frequency
10Hz 100Hz 1.0KHz 10KHz 100KHz

DB(V(6))
-40

0

40

SEL>>

P(V(6))
0d

50d

100d
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II-2-2-3-3) Interprétation des résultats :

Un filtre passe-haut actif est un filtre qui laisse passer les hautes fréquences et qui

atténue les basses fréquences, c'est-à-dire les fréquences inférieures à la fréquence de coupure.

La fréquence de coupure à -3dB est définit par : fc = .

A.N. R = 10 kΩ et C = 10 nF d’où fc =1,6 KHz

Les mesures nous donnent 1.6kHz comme fréquence de coupure à -3dB.

Cette valeur est conforme à la valeur théorique calculée.

II-2-2-4) Correction d’un système asservis :

II-2-2-4-1) Simulation à partir de l’éditeur schéma :

Supposant un système bouclé, dont le processus a pour fonction de transfert :( ) = ( )( . ), cherchons la valeur de G1 de G qui permet d’obtenir une marge de

phase de 45° afin de trouver la stabilité du système.

Le calcul théorique donne G1=15, recherchant maintenant cette valeur à partir d’une

simulation.

Pour cela on définit le paramètre globale G, et on le fait varier de 0 à 25 par pas de 5.

 Dessin de schéma sous OrCAD Pspice :

Figure II.84 : saisie de schéma sous Orcad Capture

Remarque :

Pour faire apparaitre le champ AC=1,en double cliquant sur Vpulse, on accède à ses

propriétés, on saisie la valeur 1 dans le champ AC, on sélectionne la colonne AC puis on

clique sur « Display… » et enfin choisit d’afficher le nom et la valeur.

Pour étudier la marge de phase, il faut réaliser une étude fréquentielle, c’est pour cela que

nous avant renseigné le champ AC.



Chapitre II                                                                                                 Application du Pspice à la pédagogie

109

 Configuration :

Après création d’un nouveau profil, on choisit l’option AC Sweep/Noise dans « Analysis

type » pour visualiser une analyse fréquentielle.

On règle les paramètre comme suit :

Figure II.85 : fenêtre de configuration de correction d’un système asservis.opj

Une fois ce réglage effectué, on coche sur « parametric Sweep » (dans Options) puis sur

« Global parameter » et on régle les différents paramètres, comme indiqués sur la figure

suivante :
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Figure II.86 : fenêtre de configuration « parametric sweep » de correction d’un système

asservis .opj

On valide par « Ok ».

 Simulation :

Après avoir sauvegardé le circuit, on lance la simulation.

Une fois celle-ci terminée et Pspice AD lancé, on choisit « Performance Analysis » du menu

Trace. Cliquant sur « Wizard » puis « Next », la fenêtre suivante apparait :

Figure II.87 : choix de la fonction

On sélectionne PhaseMargin.

On clique sur « Next » ; la fenêtre suivante apparait.
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Figure II.88 : définition de la fonction PhaseMargin (,)

On remplit la boite de dialogue comme indiqué sur la figure et on clique sur « Finish ».

On obtient ainsi la courbe suivante :

Figure II.89 : le résultat de simulation

En utilisant les curseurs, il est facile de vérifier que la marge de phase est de 45°pour  G=15.

G
0 5 10 15 20 25
PhaseMargin(DB(V(sortie)), P(V(sortie)))

20

40

60

80

(15.667,45.081)
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II-2-2-4-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivant :

Figure II.90 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Système asservis

*description des composants

R1  3 0 1OK

E1 3 2 LAPLACE {V(3)} {({G})/((1+S)*(1+0.125*s))}

E2 2 1 value {v(1,3)}

*definition des sources

V1 1 0 AC 1 PULSE (0 5 0 1n 1n 1 2)

.PARAM G 10

.STEP LIN PARAM G 0 25 5

.AC DEC 400 10m 1K

.PROBE

.END

 On nomme le fichier «Système asservis.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.
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 Le module PROBE donne les résultats suivants :

Figure II.91 : le résultat de simulation

II-2-3) Application au module de logique et calculateur (TEC 480) :

II-2-3-1) Circuit d’une fonction logique :

II-2-3-1-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.92 : saisie de schéma sous Orcad Capture

N.B :

Pour les simulations numériques, on peut définir comme source logique un stimulus de

1 bit STM1.Il est également possible de définir des stimuli de 4, 8 ou 16 bits pour des

simulations particulières. Ce signal binaire se définit en termes de temps et niveau logique.

Donc, dans la fenêtre d’édition, on précise pour chaque ligne notée COMMAND : le temps

puis le niveau logique en laissant un espace entre les deux.

De cette manière, il est possible d’éditer n’importe quelle allure de signal binaire non

périodique et même un signal d’horloge (périodique).
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En double cliquant sur les différentes sources d’entrée, on peut configurer l’allure de nos

signaux logiques :

DSTM4 :

Figure (II.93) : précision des commandes dans la fenêtre d’édition pour DSTM4

DSTM5 :

Figure (II.94) : précision des commandes dans la fenêtre d’édition pour DSTM5

DSTM6 :

Figure (II.95) : précision des commandes dans la fenêtre d’édition pour DSTM6

 Configuration :

Après création d’un profil de simulation, on effectue une analyse temporelle d’une durée de

4s, comme indiqué sur la figure suivante :

Figure II.96 : fenêtre de configuration de fonction logique.opj

 Simulation :

Le circuit est prêt à être simulé.
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Cliquant sur le bouton ,ou bien on sélectionne Run dans le menu Pspice.

Le tracé des entrées et des sorties sous PROBE, nous donne la figure suivante :

Figure II.97 : visualisation des résultats de simulation

II-2-3-1-2) Simulation à partir d’un fichier.cir

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.98 : localisation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

fonction logique

X1 B C D 7408

X2 A D E 7432

U1 STIM (1,1)

+ $G_DPWR $G_DGND A IO_STM IO_LEVEL=0 0s 0 REPEAT FOREVER

+0.5s 1 +0.5s 0 ENDREPEAT

U2 STIM (1,1)

+ $G_DPWR $G_DGND B IO_STM IO_LEVEL=0 0s 0 REPEAT FOREVER

+ +0.25s 1 +0.25s 0 ENDREPEAT

U3 STIM (1,1)

TimeTime
0s 1.0s 2.0s 3.0s 4.0s

        A
        B
        C
        D
        E

S1
DSTM1

E

U3A

7432

1

2
3

A

S1
DSTM2

S1
DSTM3

U2A

7408

1

2
3 D

C

B
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+ $G_DPWR $G_DGND C IO_STM IO_LEVEL=0 0s 1 REPEAT FOREVER

++1s 0 +1s 1 ENDREPEAT

.LIB EVAL.LIB

.TRAN 0s 4s

.PROBE

.END

 On nomme le fichier «la fonction logique.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.99 : les résultats de simulation

TimeTime
0s 1.0s 2.0s 3.0s 4.0s

        A
        B
        C
        D
        E
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Commentaires :

On voit bien la correspondance entre les résultats obtenus par simulation et la table de vérité

de la fonction logique.

A B C D E

0 0 0 0 0

0 1 0 0 0

1 0 0 0 1

1 1 0 0 1

0 0 1 1 0

0 1 1 1 1

1 0 1 1 1

1 1 1 1 1

Figure II.100 : la table de vérité de la fonction logique

II-2-3-2) La porte inverseuse :

II-2-3-2-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.101 : saisie de schéma sous Orcad Capture

En double cliquant sur la source d’entrée 1, on peut  configurer l’allure du signal logique :

Figure (II.102) : précision des commandes dans la fenêtre d’édition pour DSTM1

 Configuration :

Après création d’un profil de simulation, on effectue une analyse temporelle d’une durée de

20ms, comme indiqué sur la figure suivante :
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Figure II.103 : fenêtre de configuration de la porte inverseuse.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton ,ou bien on sélectionne Run dans le menu Pspice.

Le tracé des entrées et sorties sous PROBE, nous donne les courbes suivantes :

Figure II.104 : les résultats de simulation

TimeTime
0s 5ms 10ms 15ms 20ms

        1
   SORTIE
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II-2-3-2-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.105 : saisie de schéma sous Orcad Capture

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

LA PORTE INVERSEUSE

X1 1 SORTIE 7404

U1 STIM (1,1)

+ $G_DPWR $G_DGND 1 IO_STM IO_LEVEL=0

+ 0s 0       REPEAT FOREVER +2.5ms 1 +2.5ms 0 ENDREPEAT

.LIB EVAL.LIB

.TRAN 0s 20m

.PROBE

.END

 On nomme le fichier «la porte inverseuse.cir » puis on le  sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.106 : les résultats de simulation

S1
DSTM1

U1A

7404

1 2 sortie

TimeTime
0s 5ms 10ms 15ms 20ms

        1
   SORTIE
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II-2-3-2-3) Commentaires :

Les résultats obtenus sont conformes à la table de vérité d’un inverseur.

Entrée (1) Sortie

0 1

1 0

Figure II.107 : la table de vérité d’un inverseur

II-2-3-3) La bascule RS :

II-2-3-3-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.108 : saisie de schéma sous Orcad Capture

En double cliquant sur les deux sources d’entrée, on peut configurer l’allure de nos signaux

logiques :

DSTM6 :

Figure II.109 : précision des commandes dans la fenêtre d’édition pour DSTM6

DSTM7 :

Figure II.110 : précision des commandes dans la fenêtre d’édition pour DSTM7

 Configuration :

Après création d’un profil de simulation, on effectue une analyse temporelle d’une durée de

9us, Comme indiqué sur la figure suivante :
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Figure II.111 : fenêtre de configuration de la bascule RS.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton ,ou bien on sélectionne Run dans le menu Pspice.

Le tracé des entrées et sorties sous PROBE, nous donne les courbes suivantes :

Figure II.112 : visualisation des résultats sous Probe

TimeTime
0s 2us 4us 6us 8us 10us

        R
        S
        Q
     Qbar
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II-2-3-3-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.113 : saisie de schéma sous Orcad Capture

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

La bascule RS

X1 R Qbar Q 7402

X2 Q S Qbar 7402

U1 STIM (1,1)

+ $G_DPWR $G_DGND R IO_STM IO_LEVEL=0

+ 0s 1   0.2us 0   1us 1   2us 0 3us 1   5us 0   8us 1

U2 STIM (1,1)

+ $G_DPWR $G_DGND S  IO_STM IO_LEVEL=0

+ 0s 0 3us 1 4us 0 6us 1 7us 0 8us 1

.LIB EVAL.LIB

.TRAN 0s 9u

.PROBE

.END

 On nomme le fichier «la bascule RS.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

S
Qbar

U12A

7402

2

3
1

R
QS1

DSTM6

S1
DSTM7

U11A

7402

2

3
1
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 Le module PROBE donne les résultats suivants :

Figure II.114 : les résultats de simulation

II-2-3-3-3) Commentaires :

On voit bien la correspondance entre les résultats obtenus par simulation et la table de vérité

de la bascule RS.

Figure II.115 : la table de vérité d’une bascule RS

TimeTime
0s 2us 4us 6us 8us 10us

        R
        S
        Q
     Qbar

S R Qn+1 Qn+1 bar

0 0 Qn Qn bar

0 1 0 1

1 0 1 0

1 1 0 0
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II-2-3-4) La bascule JK :

II-2-3-4-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.116 : saisie de schéma sous Orcad Capture

En double cliquant sur la source d’entrée  E1, on peut  configurer l’allure du signal logique :

Figure II.117 : précision des commandes dans la fenêtre d’édition pour DSTM1

 Configuration :

Après création d’un profil de simulation, on effectue une analyse temporelle d’une durée de

20ms, Comme indiqué sur la figure suivante :

Figure II.118 : fenêtre de configuration de la bascule JK.opj
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Remarque :

Si on utilise des bascules ou des compteurs, il faudra penser à initialiser toutes

les bascules à 0. Pour cela, on clique sur Pspice→ Edit Simulation Profile, puis sur l’onglet

Options et on met initialize all flip-flops à 0 :

Figure II.119 : initialisation des bascules à 0

 Simulation:

Le circuit est prêt à être simulé.

Cliquant sur le bouton , ou bien on sélectionne Run dans le menu Pspice.
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Le tracé des entrées et sorties sous PROBE, nous donne les courbes suivantes :

Figure II.120 : les résultats de simulation

II-2-3-4-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.12 : localisation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

la bascule JK

X E1 $D_HI $D_HI $D_HI Q Qbar 74107

U1 STIM (1,1)

+ $G_DPWR $G_DGND E1 IO_STM IO_LEVEL=0

+  0s 0   2.5ms 1   5ms 0   7.5ms 1  10ms 0   12.5ms 1   15ms 0   17.5ms 1 20ms 0

.LIB EVAL.LIB

.TRAN 0s 20m

.OPTIONS DIGINITSTATE= 0

TimeTime
0s 5ms 10ms 15ms 20ms

       E1
        Q

U1A

74107

1

4

13

3

2
12

J

K

C
LR

Q

Q
CLKS1

E1

HI

HI
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.PROBE

.END

 On nomme le fichier «la bascule JK.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.122 : visualisation des résultats sous Probe

II-2-3-4-3) Commentaires :

Les résultats obtenus sont conformes à la table de vérité de la bascule JK.

J K Qn+1

0 0 Qn

0 1 0

1 0 1

1 1 Q bar

Figure II.123 : table de vérité de la bascule JK

TimeTime
0s 5ms 10ms 15ms 20ms

       E1
        Q
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II-2-3-5) Le compteur asynchrone modulo 8 :

II-2-3-5-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.124 : saisie de schéma sous Orcad Capture

En double cliquant sur la source d’entrée  E1, on peut  configurer l’allure du signal logique :

Figure (II.125) : précision des commandes dans la fenêtre d’édition pour DSTM1

 Configuration :

Après création d’un profil de simulation, on effectue une analyse temporelle d’une durée de

100ms, Comme indiqué sur la figure suivante :

Figure II.126 : fenêtre de configuration du compteur asynchrone modulo 8.opj
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Initialisant toutes les bascules à 0, comme indiqué sur la fenêtre suivante :

Figure II.127 : initialisation des bascules à 0

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton , ou bien on  sélectionne Run dans le menu Pspice.

Le tracé des entrées et sorties sous PROBE, nous donne les courbes suivantes :

Figure II.128 : les résultats de simulation
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II-2-3-5-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.129 : localisation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

compteur asynchrone

X1   E1     $D_HI      $D_HI     $D_HI    Q0      Q0bar     74107

X2   Q0     $D_HI      $D_HI     $D_HI     Q1    Q1bar     74107

X3    Q1    $D_HI     $D_HI     $D_HI      Q2    Q2bar     74107

U1 STIM(1,1)

+ $G_DPWR $G_DGND E1 IO_STM IO_LEVEL=0 0s 0

+REPEAT FOREVER +5ms 1 +5ms 0 ENDREPEAT

.LIB EVAL.LIB

.OPTIONS DIGINITSTATE= 0

.TRAN 0s 100m

.PROBE

.end

 On nomme le fichier «le compteur asynchrone modulo 8.cir » puis on le  sauvegarde à

l’endroit qu’il faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

HI
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 Le module PROBE donne les résultats suivants :

Figure II.130 : visualisation des résultats sous Probe

II-2-4) Application au module fonction de l’électronique (Tec 588) :
II-2-4-1) Circuit intégrateur :

II-2-4-1-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.131 : saisie de schéma sous Orcad Capture

 Configuration :

Après création d’un nouveau profil de simulation, on effectue une analyse temporelle de

durée de 1ms avec un pas de 1us, comme indiqué sur la figure suivante :

TimeTime
0s 20ms 40ms 60ms 80ms 100ms

       E1
       Q0
       Q1
       Q2
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Figure II.132 : fenêtre de configuration du circuit intégrateur.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton , ou bien on sélectionne Run dans le menu Pspice.

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne le

graphique suivant :

Figure II.133 : visualisation des résultats sous Probe
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II-2-4-1-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure (II.134) : localisation et numérotation des nœuds

 On Saisit la description du circuit en langage Spice dans l’éditeur de texte :

circuit intégrateur

V1 1 0 pulse(-2 2 0 0 0 100u 200u)

R1 1 2 7meg

C1 2 0 30p

.IC V(2)=0

.TRAN 1u 1m

*analyse temporelle de durée de 1m

.PROBE

.END

 On nomme le fichier « circuit intégrateur.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.
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 Le module PROBE donne les résultats suivants :

Figure II.135 : les résultats de simulation

II-2-4-1-3) Interprétation des résultats :

A haute fréquence, c’est-à-dire si w >> le condensateur n’a pas le temps de se charger et

la tension à ses bornes reste faible.

On a w = 2 = = . = 31400 rd/s et = 4761Ω d’où w >> .

II-2-4-2) Circuit dérivateur :

II-2-4-2-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.136 : saisie de schéma sous Orcad Capture

Time
0s 0.2ms 0.4ms 0.6ms 0.8ms 1.0ms

V(1) V(2)
-2.0V

0V

2.0V
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 Configuration :

On désire effectuer une analyse temporelle (ou transitoire), ce qui signifie qu’on veut

observer la variation des tensions en fonction du temps aux nœuds marqués.

Pour créer un nouveau profil, on doit cliquer sur l’icône , donner un nom au profil,

puis cliquer sur Create. La fenêtre de dialogue apparait, dont on choisit l’option Time Domain

et une durée de simulation de 10ms avec un pas de 1us, comme indiqué sur la figure suivante :

Figure II.137 : fenêtre de configuration du circuit dérivateur.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton ,ou bien on sélectionne Run dans le menu Pspice.
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Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne le

graphique suivant :

Figure II.138 : visualisation des résultats sous Probe

II-2-4-2-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.139 : localisation et numérotation des nœuds

Time
0s 2ms 4ms 6ms 8ms 10ms

V(V1:+) V(C1:2)
-10V

0V

10V
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 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

circuit dérivateur

V1 1 0 pulse(-5 5 0 0 0 1m 2m)

C1 1 2 30p

R1 2 0 1.2meg

.TRAN 1u 10m

*analyse temporelle de durée de 10ms

.PROBE

.END

 On nomme le fichier « circuit dérivateur.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants

Figure II.140 : les résultats de simulation

II-2-4-2-3) Interprétation des résultats :

A basse fréquence, c’est-à-dire si w << le condensateur à le temps de se charger

quasiment complètement.

On à w = . = 3140 rd/s  et = 27777.78 Ω d’où  w << .

Time
0s 2ms 4ms 6ms 8ms 10ms

V(1) V(2)
-10V

0V

10V
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II-2-4-3) L’oscillateur astable à transistor :

II-2-4-3-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous  OrCAD Capture :

Figure II.141 : saisie de schéma sous Orcad Capture

Remarque :

Pour l’étude de certains oscillateurs, PSpice à un défaut qui nécessite une astuce. En

effet, avant toute analyse, il effectue une simulation du point de fonctionnement stable et il

débute l’analyse en supposant le circuit dans ce point de fonctionnement. A cause de ce

principe, les oscillateurs peuvent ne jamais démarrer. Cette remarque est particulièrement

vraie pour l’astable à 2 transistors et 2 condensateurs : dans la réalité les tensions de bruit font

qu’une des capacités est initialement à un potentiel différent de l’autre or PSpice les placera

au même potentiel au démarrage, ce qui empêchera les oscillations de débuter.  Pour remédier

à cet inconvénient, il suffit de déclarer qu’une des capacités est initialement chargée soit en

double cliquant sur la capacité concernée et en déclarant la tension initiale dans

« IC= »(Initial Condition), soit en mettant le composant IC ; ensuite on doit demander une

analyse transitoire en tenant compte des conditions initiales (valider Skip initial transient

solution dans le setup de Transient). La simulation est alors correcte.

 Configuration :

On désire effectuer une analyse temporelle, ce qui signifie qu’on veut observer la

variation de la tension en fonction du temps aux nœuds marqués.

Après création d’un nouveau profil, on choisit l’option Time Domain (Transient) dans

Analysis type, dont la durée de simulation est de 5ms et le pas de calcul est de 1μs, comme le

montre la boite de dialogue de l’option new simulation profile du menu Pspice.
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Figure II.142 : fenêtre de configuration de l’oscillateur astable à transistor.opj

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquons sur pspice → Run, ou bien sur l’icône

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne les

courbes : V(Q1 :C) et V(Q2 :C).

On ajoute les courbes visualisées au niveau de la base de T1 et de T2, comme suit :

Plot→ add plot to window, une autre fenêtre apparait, puis on cliquant sur  Trace→Add Trace

on sélectionne  VB(Q1), VB(Q2) et on valide par « Ok ».

Les résultats de simulation sont les suivants:



Chapitre II                                                                                                 Application du Pspice à la pédagogie

140

Figure II.143 : visualisation des résultats sous Probe

II-2-4-3-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.144 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Astable

* Description des composants

Q1 2 4 0 Q2N2222

Q2 5 3 0 Q2N2222

RC1 2 1 1K

RB1 4 1 47K

Time
0s 1.0ms 2.0ms 3.0ms 4.0ms 5.0ms

V(Q1:c) V(Q2:c)
0V

10V

20V
VB(Q1) VB(Q2)

-10V

0V

10V

SEL>>
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RC2 5 1 1K

RB2 3 1 47K

C1 2 3 15n

C2 4 5 15n

.IC V(2)=10

*Définition des sources

V1 1 0 DC 10V

.LIB EVAL.LIB

.TRAN  1u    5ms

.Probe

.END

 On nomme le fichier « Astable à transistor.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.145 : les résultats de simulation

II-2-4-3-3) Interprétation des résultats :

On remarque deux états instables entre lesquels le circuit évolue d’une façon

périodique. Dans le premier état, on a : T1 bloqué, T2 saturé. Après un certain temps on

suppose que la base de T1 devient légèrement positive : T1 se sature et son potentiel de

collecteur diminue brutalement. Une impulsion de tension négative est générée sur ce

collecteur. Comme le potentiel passe de V1 (10v) à 0, le potentiel passe de (voisin

de 0.6v) à (-V1)+VBE car la charge Q=C1.V1 du condensateur n’a pas le temps de varier

pendant la durée de la transition. Le potentiel de la base de T2 devenant négatif, celui-ci se

Time
0s 1.0ms 2.0ms 3.0ms 4.0ms 5.0ms

V(2) V(5)
0V

10V

20V
V(4) V(3)

-10V

0V

10V

SEL>>
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bloque(le deuxième état). Le potentiel de son collecteur croit vers V1, Le condensateur C2 se

charge à travers RC2 et l’espace base émetteur du transistor T1 (qui est alors saturé) avec une

constante de temps égale à τ2=RC2.C2 (15µs). Le potentiel de la base de T1 reste légèrement

positif ce qui assure le maintien de sa saturation. Après le blocage de T2, le potentiel de sa

base VB2 croit de (–V1)+VBE à VBE avec une constante de temps τ1=RB2.C1(675µs ) car le

condensateur  C1 se charge à travers RB2 et l’espace collecteur émetteur de T1 qui est saturé

(le deuxième état). Quand VB2 dépasse la tension de seuil VBE le système bascule vers son

autre état. Le système oscille en permanence entre ces deux états instables.

II-2-4-4) Oscillateur Astable à NE555

II-2-4-4-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Pspice :

Figure II.146 : saisie de schéma sous Orcad Capture
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 Configuration :

Après création d’un nouveau profil de simulation, on effectue une analyse temporelle de

durée de 100ms avec un pas de 10us et on coche skip the initial … (SKIPBP), comme indiqué

sur la figure suivante :

Figure II.147 : fenêtre de configuration de l’oscillateur astable à NE555.opj

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur le bouton , ou bien on sélectionne Run dans  le menu Pspice.

La figure suivante montre la fenêtre PROBE, qui représente la réponse temporelle des signaux

V(R4 :1) et V(VC1).

Figure II.148 : les résultats de simulation

Time
0s 20ms 40ms 60ms 80ms 100ms

V(R4:1) V(VC)
0V

10V

20V
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II-2-4-4-2) Simulation à partir d’un fichier.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.149 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Astable NE555

*description des composants

R1 1 2 150K

R2 2 3 15V

R3 4 5 27K

R4 1 7 10K

D1 4 3 D1N4148

D2 3 5 D1N4148

C1 5 0 150n

X1 0 5 7 1 6 5 3 1 555D

.IC V(5)=0

C2 6 0 10n

*définition des sources

V1 1 0 15V

*La commande .lib eval.lib charge automatiquement les model des composants utilisés
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.LIB EVAL.LIB

.TRAN 10u 100m

.PROBE

.END

 On nomme le fichier « Astab555.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.150 : visualisation des résultats sous Probe

II-2-4-4-3) Interprétation des résultats :

Le condensateur (C1) se charge à travers R1+R2 sous Vcc (=15V) avec Vc nul selon := . /( ) , jusqu’à ce que Vc (=Vseuil=Vdeclenchement) atteigne 2/3Vcc

(=10v). La sortie passe à l’état bas et le transistor devient passant; le condensateur se décharge

à travers R3 selon Vc= 2/3 Valim.e-t/R2C jusqu'à ce que VC (=Vseuil=Vdécl) atteigne 1/3Vcc

(=5V). a sortie passe à l’état haut et le transistor est bloqué; le condensateur se charge à

travers R1+R2 sous Vcc selon = (1 − /( ) ) jusqu’à ce que Vc atteigne

2/3Vcc (=10V). La sortie passe alors à l’état bas et le transistor est passant. On retrouve alors

la situation précédente. Donc on observe une oscillation périodique de Vs et de Vc entre 0V et

Vcc (ou entre 1/3 Vcc et 2/3 Vcc pour Vc). Le montage ne parvient pas à trouver un état

d'équilibre, il est astable.

Time
0s 20ms 40ms 60ms 80ms 100ms

V(5) V(7)
0V

10V

20V
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II-2-4-5) Oscillateur monostable à NE555 :

II-2-4-5-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous  OrCAD Capture :

Figure II.151 : saisie de schéma sous Orcad Capture

 Configuration :

On désire effectuer une analyse temporelle, ce qui signifie qu’on veut observer la variation

de la tension en fonction du temps.

Après création d’un nouveau profil, on choisit l’option Time Domain (Transient) dans

Analysis type, dont la durée de simulation est de 100 ms et le pas de calcul est de 10 µs,

comme le montre la boite de dialogue de l’option new simulation profile du menu Pspice.
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Figure II.152 : fenêtre de configuration de l’oscillateur monostable à NE555.opj

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur pspice → Run, ou bien sur l’icône

La fenêtre suivante s’ouvre :

Figure II.153 : la fenêtre Probe

On clique sur Trace →Add Trace, la fenêtre suivante apparait :
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Figure II.154 : sélection des courbes à visualiser

On sélectionne V (DSTM :1), puis on valide par « Ok ».

Pour l’ajout d’une fenêtre, cliquons Plot→Add Plot to Window, une autre fenêtre apparait,

ensuite on fait Trace→Add trace et on choisit V(X1 :THRESHOLD), on valide par « Ok » et

enfin on ajoute V(R1 :2).

La fenêtre des résultats  donne les courbes suivantes :

Figure II.155 : visualisation des résultats sous Probe

Time
0s 20ms 40ms 60ms 80ms 100ms

V(DSTM1:1)
0V

2.5V
5.0V

V(X1:THRESHOLD)
0V

2.5V
5.0V

V(R1:2)
0V

2.5V
5.0V

SEL>>
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II-2-4-5-2) Simulation à partir d’un fichier d’entrée.cir

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.156 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :
Monostable à NE555

*description des composants

R1 5 0 10K

R2 1 3 4.7K

C1 2 0 0.01u

C2 1 0 2.2u

X1 0 4 5 3 2 1 1 3 555D

.LIB EVAL.LIB

*définition des sources

UDSTM1 STIM (1, 1) $G_DPWR $G_DGND IO_STM IO_LEVEL=0

+ 0 1 +1ms 0 REPEAT FOREVER +1ms 1 +0.02s 0 ENDREPEAT

V1 3 0 5V

.TRAN 10u 100m

.PROBE

.END
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 On nomme le fichier « monostable à NE555.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.157 : les résultats de simulation

II-2-4-5-3) Interprétation des résultats :

L’état de base du montage est le suivant : la tension d’entrée DSTM est haute (c'est-à-

dire DSTM>1/3VCC) ; la sortie est donc basse et le transistor est passant. Le condensateur C2

ne peut pas se charger et on a Vc= Vseuil=0V .Le montage va réagir à une impulsion de DSTM

c'est-à-dire à un bref  passage de DSTM à l’état bas (DSTM < 1/3VCC).

Vdécl(=DSTM) devient inférieur à 1/3 VCC; la sortie passe à l’état haut et le transistor est

bloqué.le condensateur C2 se charge lentement à travers R2 selon la loi Vc=VCC. (1 e-t/RC).

Quand Vdécl repasse à l’état haut (Vdécl>1/3 VCC), le condensateur continue de se charger tant

que Vseuil< 2/3 VCC .Quand Vseuil atteint 2/3 VCC, la sortie revient à l'état bas et le transistor est

passant; le condensateur C2 se décharge quasi instantanément dans le transistor et Vseuil passe

à 0V.on retrouve la situation “de base“ ; le montage est prêt à réagir à une autre impulsion…le

montage fournit donc un potentiel (Voutput) haut (=VCC) en sortie pendant une durée T, en

réponse à une impulsion en entrée.

On peut calculer T, qui est le temps nécessaire au condensateur C pour se charger de 0V à 2/3

VCC à travers R : T = RC. Ln3 = 11.35 ms.

Time
0s 20ms 40ms 60ms 80ms 100ms

V(4)
0V

2.5V
5.0V

V(1)0V
2.5V
5.0V

V(5)
0V

2.5V
5.0V

SEL>>
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II-2-4-6) Trigger de schmitt :

II-2-4-6-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Capture :

Figure II.158 : saisie de schéma sous Orcad Capture

 Configuration :

On désire effectuer une analyse temporelle (ou transitoire), ce qui signifie qu’on veut

observer la variation des tensions en fonction du temps aux nœuds marqués.

Pour créer un nouveau profil, il faut cliquer sur l’icône , donner un nom au profil, puis

cliquer sur Create. La fenêtre de dialogue apparait, dont on choisit l’option Time Domain et

une durée de simulation de 10ms avec un pas de 1us, comme indiqué sur la figure suivante :
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Figure II.159 : fenêtre de configuration de trigger de schmitt.opj

 Simulation :

Le circuit est alors prêt à être simulé.

Cliquant sur le bouton ,ou bien on sélectionne Run dans le menu Pspice.

La figure suivante montre la fenêtre PROBE, qui représente la réponse temporelle des signaux

V2 et Vc2.

Figure II.160 : visualisation des résultats sous Probe

Time
0s 2ms 4ms 6ms 8ms 10ms

V(R4:1) V(T2:c)
-10V

0V

10V

20V
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Si on veut visualiser le cycle d’hystérésis, il suffit de représenter VC2 en fonction de l’entrée

V2, pour cela on change l’axe des abscisses comme indiqué sur la figure :

Figure II.161 : visualisation du cycle d’hystérésis

II-2-4-6-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.162 : localisation et numérotation des nœuds
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 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Trigger de schmitt

*description des composants

R1 3 5 1K

R2 4 6 1K

R3 0 7 200

R4 1 2 15K

RC1 3 4 9.3K

RB2 0 5 10K

Q1 3 2 7 Q2N2222

Q2 6 5 7 Q2N2222

*définition des sources

V1 4 0 DC 10

V2 1 0 sin(0 3.5 1K)

.LIB EVAL.LIB

.TRAN 5us 10ms

.PROBE

.END

 On nomme le fichier « Trigger de schmitt.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure II.163 : les résultats de simulation

Time
0s 2ms 4ms 6ms 8ms 10ms

V(1) V(6)
-10V
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10V
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II-2-4-6-3) Interprétation des résultats :

Dans l’état initial, qui est l’état stable du système, le transistor T1 est bloqué et T2 est

saturé. Soit VE le potentiel commun des deux émetteurs. Dans cet état, la tension de sortie

(collecteur de T2 qui est saturé) est égale à U0=VE avec : VE=VB2-VBE ≈ . −VBE

Quand la tension d’entrée V2 dépasse la valeur U0+ VBE, le transistor T1 se met à conduire et

le potentiel de son collecteur diminue tandis que le potentiel des émetteurs varie jusqu’à une

valeur U1 ≈V1.R3 / RC1+R3. Le potentiel de base du transistor T2 diminue ainsi que ses

courants collecteur et émetteur. Le potentiel VE diminue ce qui contribue à augmenter la

conduction de T1. Il y a un effet cumulatif qui entraine le basculement définitif du système.

La diminution de la tension d’entrée en-dessous de la valeur U1+VBE produira l’effet inverse.

II-2-5) Application au module d’électricité générale (Tec 581) :
II-2-5-1) Circuit diviseur de tension :

II-2-5-1-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Pspice :

Figure II.164 : saisie de schéma sous Orcad Capture

 Configuration :

Après création d’un profil de simulation, on effectue une analyse de type Bias Point, comme

indiqué sur la figure suivante :
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Figure II.165 : fenêtre de configuration du circuit diviseur de tension.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton , ou bien on sélectionne Run dans le menu Pspice.

Cliquant sur les icones , ce qui va nous permettre d’évaluer le courant de

chaque branche et les tensions de tous les nœuds du circuit dans des conditions d’état stable

établis, comme indiqués sur la figure suivante :

Figure II.166 : les résultats de simulation
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II-2-5-1-2) Simulation à partir d’un fichier d’entrée.cir :

le circuit à modéliser est représenté sur la figure suivante :

Figure II.167 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

diviseur de tension

*description du circuit

R1 1 2 1K

R2 2 0 1K

*définition des sources

V1 1 0 DC 10V

.OP

.PROBE

.END

 On nomme le fichier «diviseur de tension.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 La fenêtre  view simulation output file de l’icone suivante (le fichier .out) donne les

résultats  suivants :
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Figure (II.168) : les résultats de simulation obtenus dans le fichier.out

II-2-5-2) Lois de Kirchhoff 1 :

II-2-5-2-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Pspice :

Figure II.169 : saisie de schéma sous Orcad Capture

 Configuration :

Après création d’un profil de simulation, on effectue une analyse de type Bias Point, comme

indiqué sur la figure suivante :
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Figure II.170 : fenêtre de configuration de lois de Kirchhoff 1.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton ,ou bien on sélectionne Run dans le menu Pspice.

Cliquons sur les icones , ce qui va nous permettre d’évaluer le courant de

chaque branche et les tensions de tous les nœuds du circuit dans des conditions d’état stable

établis , comme indiqués sur la figure suivante :

Figure II.171 : les résultats de simulation
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II-2-5-2-2) Simulation à partir d’un fichier d’entrée.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.172 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

lois de kirchhof 1

*description des composants

R1 1 2 3

R2 2 0 3

R3 1 3 1

R4 3 0 5

R5 2 3 1.67

*définition des sources

V1 1 0 12V

.OP

.PROBE

.END

 On nomme le fichier «lois de kirchhoff 1.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.
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 La fenêtre  view simulation output file de l’icone suivante (le fichier .out) donne les

résultats  suivants :

Figure (II.173) : les résultats de simulation obtenus dans le fichier.out

II-2-5-3) Lois de Kirchhoff 2 :

II-2-5-3-1) Simulation à partir de l’éditeur schéma :

 Dessin de schéma sous OrCAD Pspice :

Figure II.174 : saisie de schéma sous Orcad Capture

 Configuration :

Après création d’un profil de simulation, on effectue une analyse de type Bias Point, comme

indiqué sur la figure suivante :
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Figure II.175 : fenêtre de configuration de lois de Kirchhoff 2.opj

 Simulation :

Le circuit est prêt à être simulé.

Cliquant sur le bouton ou on sélectionne Run dans le menu Pspice.

Cliquant sur les icones , ce qui va nous permettre d’évaluer le courant de

chaque branche et les tensions de tous les nœuds du circuit dans des conditions d’état stable

établis, comme indiqués sur la figure suivante :

Figure II.176 : les résultats de simulation
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II-2-5-3-2) Simulation à partir d’un fichier.cir :

Le circuit à modéliser est représenté sur la figure suivante :

Figure II.177 : localisation et numérotation des nœuds

 On saisit la description du circuit en langage Spice dans l’éditeur de texte :

Lois de Kirchhoff 2

*description du circuit

R1 1 2 20

R2 0 2 20

R3 2 3 10

R4 0 3 20

R5 3 4 10

*définition des sources

V1 1 0 DC 80V

V2 4 0 DC 45V

.OP

.PROBE

.END

 On nomme le fichier «Lois de Kirchhoff 2.cir » puis on le sauvegarde à l’endroit qu’il

faut.

 Chargeant le fichier.cir  afin de lancer la simulation du circuit.

 La fenêtre  view simulation output file de l’icone suivante (le fichier .out) donne les

résultats  suivants :
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Figure II.178 : les résultats de simulation obtenus dans le fichier.out

II-3) Discussion :
L’ensemble des résultats obtenus par simulation, concordent avec ceux obtenus

théoriquement et lors des séances de TP ; nous concluons que ce logiciel (Pspice) permet

d’évaluer de manière précise les performances d’un circuit électronique.
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III-1) Préambule :
Aujourd’hui, OrCAD Capture est la saisie de schémas électronique la plus utilisée

dans le monde, et ce pour une simple raison : il s’agit d’une solution de saisie de conception

rapide et universelle. Que nous soyons en train de concevoir un nouveau circuit analogique,

de revoir le schéma de nos circuits imprimés ou de réaliser une fonction numérique à l’aide

d’un module HDL, OrCAD Capture met à notre disposition des commandes pour saisir,

modifier et vérifier la conception d’un circuit imprimé. Vu toutes ces fonctionnalités, on va

modéliser des lignes de transmission sous Pspice et réaliser un circuit imprimé avec Orcad-

Capture-Layout.

III-2) Modélisation SPICE des lignes de transmission :

Il est souvent souhaitable de disposer d'une méthode numérique, qui est adaptée à un

ordinateur et qui traitera des charges non linéaires aussi bien que dynamiques. La méthode

suivante est attribuée à Branin. Elle n'est valable que pour les lignes sans perte. La méthode

est utilisée dans le programme d'analyse de circuit SPICE (ou PSPICE).

Afin d’obtenir les équations nécessaires, nous nous contentons de manipuler les solutions des

équations de lignes de transmission sans perte indiquées ci-dessous :

V(z, t) = V+ (t - ) + V- (t + ) (III-1)

ZCI(z, t) = V+ (t - ) – V- (t + ) (III-2)

L’évaluation des équations précédentes à la source finale, Z = 0, et la charge finale Z =L ,
donne :

V(0, t) = V+ (t) + V- (t) (III-3)

ZCI(0,t) = V’ (t) – V (t) (III-4)

et

V(L ,t) = V’ (t- TD) + V (t+ TD) (III-5)

ZCI (L ,t) = V+ (t – TD) – V- (t + TD) (III-6)

Où le retard pour la ligne est

(III-7)



Chapitre III Simulation des lignes de transmission et conception d’un circuit imprimé avec PSPICE

170

L’addition et la soustraction de 3, 4 et 5,6 donnent :

V (0, t) + ZCI(0, t) = 2V’ (t) (III-8)

V (0, t) - ZCI (0, t) = 2V- (t) (III-9)

V (L, t) + ZCI (L , t) = 2 V+( t – TD) (III-10)

V (L, t) – ZCI (L , t) = 2 V-( t + TD) (III-11)

Le réarrangement des équations donne :

V(0, t) = ZCI(0, t) + 2V- (t) (III-12)

V(L, t) = -ZCI (L, t ) + 2V+(t – TD) (III-13)

V(0, t-TD) + ZCI(0, t-TD) = 2V+(t – TD) (III-14)

V(L , t-TD) – ZCI(L , t- TD) = 2V-(t) (III-15)

En substituant 15 dans 12, on aura :

V(0, t) = ZCI (0, t) + E0(L, t-TD) (III-16)

D’où

E0(L, t- TD) = V(L, t – TD) – ZCI(L, t – TD) (III-17)

= 2V(t)

Même chose, substituant 14 dans 13, on aura :

V(L, t) = - ZCI (L, t) + EL (0, t – TD) (III-18)

D’où

EL (0, t – TD) = V(0, t- TD) + ZCI (0, t – TD)

= 2V+(t – TD) (III-19)

Les équations 17, 18 et 19 suggèrent le circuit équivalent de la ligne complète indiquée sur la
figure III.1.La source contrôlée est produite par la tension et le courant à l'entrée de la ligne à
un temps égal à un délai de transit en avance. De même, la source d'énergie contrôlée est
produite par la tension et le courant en sortie de ligne à un temps égal à un délai de transit en
avance.
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Figure III.1 : le modèle SPICE (PSPICE) de la ligne de transmission

III-2-1) Ligne de transmission N° 1 :

La figure suivante montre une ligne dans laquelle une batterie de 30V alimente une

ligne de longueur 400 m.

La ligne a une impédance caractéristique de 50Ω, et une vitesse de propagation de 200m/µs.

La résistance de la source est nulle, et la résistance de charge est de 100Ω.

On veut visualiser la tension de charge et le courant à l’entrée de la ligne.

Figure III.2 : les caractéristiques de la ligne de transmission
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III-2-1-1) Simulation par l’éditeur de texte :

III-2-1-1-1) Le modèle SPICE de la ligne de transmission :

Figure III.3 : localisation et numérotation des nœuds

III-2-1-1-2) Saisie du programme en langage Spice :

ligne de transmission 1

*description du circuit

RL 2 0 100

T 1 0 2 0 Z0=50 TD=2u

*définition des sources

VS 1 0 PWL (0 0 0.01u 30)

.TRAN 0.01U 20U

.PROBE

.END

III-2-1-1-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission1.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.
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 Le module PROBE donne les résultats suivants :

Figure III.4 : la tension de charge

Figure III.5 : le courant d’entrée de la ligne

Time
0s 5us 10us 15us 20us

V(2)
0V

20V

40V

Time
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- I(VS)
0A

200mA

400mA

600mA
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III-2-1-2) Simulation par l’éditeur schéma :

III-2-1-2-1) Saisie du schéma sous Orcad Capture :

Figure III.6 : saisie du schéma sous Capture

III-2-1-2-2) Configuration :

On désire effectuer une analyse temporelle, ce qui signifie, qu’on veut observer la

variation de la tension, et du courant en fonction du temps aux nœuds marqués.

Après création d’un nouveau profil, on choisit l’option Time Domain (Transient) dans

Analysis type, dont la durée de simulation est de 20µs et le pas de calcul est de 0.01µs,

comme le montre la boite de dialogue de l’option new simulation profile du menu Pspice.

Figure III.7 : fenêtre de configuration de ligne de transmission N°1.opj
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III-2-1-2-3) Simulation :

Le circuit est alors prêt à être simulé. Cliquant sur pspice → Run, ou bien sur l’icône

.

Après quelques secondes de compilation, la fenêtre des résultats s’ouvre et donne les

graphiques suivants :

Figure III.8 : tension de charge

Figure III.9 : le courant d’entrée de la ligne
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III-2-2) Ligne de transmission N°2 :
La figure suivante montre une ligne de 0.2m excitée par une source (une impulsion de

durée 1ns).

La ligne a une impédance caractéristique de 100Ω et une vitesse de propagation de 2×108 m/s.

La résistance de la source est de 300Ω et la résistance de charge est à l’infini.

On veut visualiser la tension à l’entrée de la ligne et la tension de charge.

Figure III.10 : les caractéristiques de la ligne de transmission

III-2-2-1) Le modèle SPICE de la ligne de transmission :

Figure III.11 : localisation et numérotation des nœuds

III-2-2-2) Saisie du programme en langage Spice

ligne de transmission 2

*description des composants

RS 1 2 300

T 2 0 3 0 Z0=100 TD=1N

*définition des sources

VS 1 0 PWL (0 0 0.01N 20 1N 20 1.01N 0)

.TRAN 0.01N 10N

.PROBE

.END



Chapitre III Simulation des lignes de transmission et conception d’un circuit imprimé avec PSPICE

177

III-2-2-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission2.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure III.12 : la tension à l’entrée de la ligne

Figure III.13 : la tension de charge

Time
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III-2-3) Ligne de transmission N°3 :
Considérons le câble coaxial indiqué sur la figure suivante.

Figure III.14 : les caractéristiques de la ligne de transmission

La source de tension est une impulsion d’amplitude 100V et de durée 6µs, la ligne est

désignée par sa capacité par unité de longueur et d’inductance : C = 100 Pf/m et l=0.25µH/m.

La ligne a une impédance caractéristique de 50Ω et une vitesse de propagation de 200m/µs.

La résistance de la source est de 150Ω et la résistance de charge est un court-circuit (RL=0Ω).

Le coefficient de réflexion de la source est : ГS = =

Le coefficient de réflexion de  la charge est : ГL = = -1

On veut visualiser la tension à l’entrée de la ligne.

III-2-3-1) Le modèle SPICE de la ligne de transmission :

Figure III.15 : localisation et numérotation des nœuds

III-2-3-2) Saisie du programme en langage Spice :

ligne de transmission 3

*description des composants

RS 1 2 150

RL 3 0 1u

T 2 0 3 0 Z0=50 TD=2u
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*définition des sources

VS 1 0 PWL (0 0 0.01u 100 6u 100 6.01u 0)

.TRAN 0.01u 20u

.PROBE

.END

III-2-3-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission3.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure III.16 : la tension à l’entrée de la ligne

Time
0s 5us 10us 15us 20us

V(2)
-40V

-20V

0V

20V

30V
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III-2-4) Ligne de transmission N°4 :
Une ligne de 2.7 m de longueur est excitée par une source de 100MHZ, comme

indiquée sur la figure.

On veut déterminer les tensions de source et de charge, sachant que ГL= 0.82/22.83°

et  ГS = 0.82/-949.17°.

Figure III.17 : les caractéristiques de la ligne de transmission

III-2-4-1) Le modèle SPICE de la ligne de transmission :

Pour résoudre le problème de cet exemple en utilisant SPICE, on doit synthétiser les

circuits équivalents composés de R, L et C qui représentent  l’impédance d’entrée ZS et

l’impédance de charge ZL. Ces deux impédances peuvent être représentées par une résistance

de 100Ω en série avec un condensateur de 31.8 pF et une résistance de 100Ω en série avec

une inductance de 0.318 µH respectivement.

Figure III.18 : localisation et numérotation des nœuds
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III-2-4-2) Saisie du programme en langage Spice :

ligne de transmission 4

RS 1 2 100

CS 2 3 31.8P

T 3 0 4 0 Z0=50 TD=13.5N

RL 4 5 100

LL 5 0 0.318U

*définition des sources

VS 1 0 AC 10 30

.AC DEC 1 1E8 1E8

.PRINT AC VM(3) VP(3) VM(4) VP(4)

.END

III-2-4-3) Résultats de simulation sous le fichier.out :

 On nomme le fichier «ligne de transmission4.cir » puis on le sauvegarde à l’endroit qu’il faut.

 Chargeant  le fichier.cir  afin de lancer la simulation du circuit.

 La fenêtre  view simulation output file de l’icône suivante (le fichier .out) donne les

résultats  suivants :

Figure III.19 : les tensions d’entrée et de charge de la ligne représentées      en amplitude

et en phase.

III-2-5) Ligne de transmission N°5 :
Considérons la ligne de transmission représentée sur la figure.

La fréquence de fonctionnement est de 100MHZ, la vitesse de propagation est de 3×108m/s et

la longueur d’onde est de 3m, d’où la longueur de la ligne de 0.3m est (1/10) λ.

Déterminant la tension d’entrée et la tension de charge.
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Figure III.20 : les caractéristiques de la ligne de transmission

III-2-5-1) Le modèle SPICE de la ligne de transmission :

Figure III.21 : localisation et numérotation des nœuds

III-2-5-2) Saisie du programme en langage Spice :

ligne de transmission 5

*description des composants

RS 1 2 10

CS 2 0 10P

L 2 3 50N

CL 3 0 10P

RL 3 0 1000

*définition des sources

VS 1 0 AC 1 0

.AC DEC 1 100MEG 100MEG

.PRINT AC VM(2) VP(2) VM(3) VP(3)

.END
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III-2-5-3) Résultats de simulation sous le fichier.out :

 On nomme le fichier «ligne de transmission5.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.cir  afin de lancer la simulation du circuit.

 La fenêtre  view simulation output file de l’icône suivante (le fichier .out) donne

les résultats  suivants :

Figure III.22 : les tensions d’entrée et de sortie de la ligne

III-2-6) Ligne de transmission N°6 :

Soit un inverseur CMOS connecté à un autre inverseur CMOS par une ligne

microruban d’impédance caractéristique de 53.4Ω, la vitesse de propagation est de 1.255ns.

La source (sortie de la porte 1) est représentée par un 2.5V, 25MHZ.

L’impédance de 25Ω est une résistance de sortie d’un inverseur CMOS, la charge est

représentée comme une capacité de 5PF.

Figure III.23 : les caractéristiques de la ligne de transmission

III-2-6-1) Le modèle SPICE de la ligne de transmission :

Nous allons simuler ce circuit à l’aide de SPICE pour déterminer la tension à l’entrée

de la ligne V(0,T) et la tension de sortie de la ligne V(L,T).

Figure III.24 : localisation et numérotation des nœuds
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III-2-6-2) Saisie du programme en langage Spice :

Ligne de transmission 6

*description des composants

RS 1 2 25

T 2 0 3 0 Z0=53.4 TD=1.255N

CL 3 0 5P

*définition des sources

VS 1 0 PWL(0 0 2N 2.5 20N 2.5 22N 0 40N 0)

.TRAN 0.04N 40N

.PROBE

.END

III-2-6-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission6.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure III.25 : la tension de charge (l’entrée de la porte CMOS)

Time
0s 10ns 20ns 30ns 40ns

V(3)
-2.0V

0V

2.0V

4.0V
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Figure III.26 : la tension à l’entrée de la ligne (la sortie de la porte CMOS)

III-2-7) Ligne de transmission N°7 :
Considérons deux inverseurs CMOS reliés par une ligne de 50Ω comme illustré sur la

figure.

L’entrée de l’inverseur CMOS à la charge est représentée par une capacité dont la valeur est

de 5pF, la sortie de l’inverseur CMOS à l’entrée de la ligne est représentée par une source de

tension dont sa résistance est de 20Ω.

On veut visualiser la tension de charge.

Figure III.27 : les caractéristiques de la ligne de transmission

Time
0s 10ns 20ns 30ns 40ns

V(2)
-2.0V

0V

2.0V

4.0V
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III-2-7-1) Le modèle SPICE de la ligne de transmission :

Figure III.28 : localisation et numérotation des nœuds

III-2-7-2) Saisie du programme en langage Spice :

ligne de transmission 7

*description des composants

RS 1 2 20

CL 3 0 5P

T 2 0 3 0 Z0=50 TD=0.2N

*définition des sources

VS 1 0 PWL(0 0 0.1N 5 5N 5 5.1N 0 10N 0)

.TRAN 0.01N 10N

.PROBE

.END

III-2-7-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission7.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.
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 Le module PROBE donne les résultats suivants :

Figure III.29 : la tension de charge

III-2-8) Ligne de transmission N°8 :
La figure suivante montre le circuit précédent plus une résistance de 30Ω placée en

série avec la sortie de la source.

On veut visualiser la tension de charge.

III-2-8-1) Le modèle SPICE de la ligne de transmission :

Figure III.30 : localisation et numérotation des nœuds

Time
0s 2ns 4ns 6ns 8ns 10ns

V(3)
-4.0V

0V

4.0V

8.0V
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III-2-8-2) Saisie du programme en langage Spice :

ligne de transmission 8

*description des composants

RS 1 2 20

R 2 3 30

T 3 0 4 0 Z0=50 TD=0.2N

CL 4 0 5P

*définition des sources

VS 1 0 PWL(0 0 0.1N 5 5N 5 5.1N 0 10N 0)

.TRAN 0.01N 10N

.PROBE

.END

III-2-8-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission8.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure III.31 : la tension de charge

Time
0s 2ns 4ns 6ns 8ns 10ns

V(4)
0V

2.5V

5.0V
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III-2-9) Ligne de transmission N°9 :
La figure suivante montre le schéma de l’exemple 8 plus une résistance de 50Ω placée

en parallèle avec la charge.

On veut visualiser la tension de charge.

III-2-9-1) Le modèle SPICE de la ligne de transmission :

Figure III.32 : localisation et numérotation des nœuds

III-2-9-2) Saisie du programme en langage Spice :

ligne de transmission 9

*description des composants

RS 1 2 20

R 3 0 50

CL 3 0 5P

T 2 0 3 0 Z0=50 TD=0.2N

*définition des sources

VS 1 0 PWL(0 0 0.1N 5 5N 5 5.1N 0 10N 0)

.TRAN 0.01N 10N

.PROBE

.END

III-2-9-3) Résultats de simulation sous Probe :

 On nomme le fichier «ligne de transmission9.cir » puis on le sauvegarde à l’endroit

qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.
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 Le module PROBE donne les résultats suivants :

Figure III.33 : tension de charge

III-2-10) Ligne de transmission N° 10 :

La figure suivante montre une ligne de transmission avec perte, d’une longueur de 1 km,

ainsi que ses paramètres R, L, G, C et LEN.

III-2-10-1) Le modèle SPICE de la ligne de transmission :

Figure III.34 : localisation et numérotation des nœuds

III-2-10-2) Saisie du programme en langage Spice :
Ligne de transmission avec perte

*description des  composants

Rsource 1 2 50

Rcharge 3 0 50

Time
0s 2ns 4ns 6ns 8ns 10ns

V(3)
-5.0V

0V

5.0V
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T1 2 0 3 0 LEN=1 R=15 L=175u G=9u C=70n

*définition des sources

V1 1 0 AC 1 DC 0

.AC DEC 10 10 100MEG

.PROBE

.END

III-2-10-3) Résultats de simulation sous Probe:

 On nomme le fichier «ligne de transmission avec perte.cir » puis on le sauvegarde à

l’endroit qu’il faut.

 Chargeant  le fichier.CIR afin de lancer la simulation du circuit.

 Le module PROBE donne les résultats suivants :

Figure III.35 : représentation graphique de l’impédance d’entrée et de la réponse en

fréquence

III-2-11) Interprétation des résultats :
Ces résultats obtenus par simulation sous spice concordent parfaitement avec ceux

obtenus théoriquement par CLAYTON R.PAUL [7] , ce qui montre la fiabilité de ce logiciel.

III-3) Réalisation d’un circuit imprimé :
La réalisation d’un circuit imprimé peut se décomposer en différentes étapes, pour

lesquelles le respect et la minutie de réalisation des étapes sont primordiaux pour obtenir

un circuit fonctionnel. Les différentes étapes sont les suivantes :

Frequency
100Hz 10KHz 1.0MHz 100MHz10Hz

DB(V(3))
-7.4

-7.3

-7.2

SEL>>

(1.0000M,-7.3254)

V(2) / IA(T1)
40

60

80

(1.0000M,50.001)



Chapitre III Simulation des lignes de transmission et conception d’un circuit imprimé avec PSPICE

192

 La saisie du schéma sous Orcad Capture, (15 % temps de réalisation).

 La recherche et la saisie des Empreintes (Footprints), (15 % temps de réalisation).

 Le Placement des composants sous Orcad Layout, (30 % temps de réalisation).

 Le Routage des Pistes en respect des contraintes, (15 % temps de réalisation).

 Vérifications avant impression du typon pour réalisation.

 Soudure des composants sur la carte, (15 % temps de réalisation).

 Essais de fonctionnement de la carte (Recette). (10 % temps de réalisation).

III-4) Flux de conception de Layout:

Le flux de conception simplifié est représenté sur la figure ci-dessous.

Figure III.36 : étapes de réalisation d’un circuit imprimé

On saisit le schéma sous Orcad Capture, à l’aide de symboles qui sont contenus, dans

des librairies (bibliothèque de symboles avec extension « .olb » ) que l’on chargera à volonté

et suivant les besoins.
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Une fois le schéma fini et vérifié, on crée la Netlist. C’est le fichier que l’on va charger sous

Orcad Layout pour faire le typon en liaison avec Orcad Capture. Il faut donc que le schéma

soit correct.

En chargeant la netlist (NomProjet.mnl), Orcad Layout va chercher les empreintes

(FootPrints) dans les librairies et affiche le « chevelu », c'est-à-dire les empreintes reliées par

des fils.

Layout utilise un modèle de technologie qui permet de configurer les paramètres suivants :

 Couche : nombre de couches et affectation de chaque couche(routage, documentation,

inutilisée…),

 valeur d’isolation : entre pistes, entre piste et pastille,…ect.

Ou bien un système de carte, qui est un modèle de technologie possédant en plus une

définition d’un contour de carte, éventuellement des trous pour la fixation, un connecteur …

Ainsi que des bibliothèques d’empreintes, d’où sont extraites les empreintes contenues dans la

« netlist ».

Le fichier principal produit à l’extension .max. Layout peut aussi générer d’autres fichiers. par

exemple : fichier produit pour une impression avec l’outil GerbTool.

III-5) Exemple de réalisation d’un circuit imprimé :
Dans cet exemple on explique en détail toutes les étapes de réalisation d’un circuit imprimé

sous Orcad Capture Layout.

III-5-1) Sous Orcad Capture :
III-5-1-1) Lancement de capture :

Aller dans le menu :

Démarrer -> Tous les Programmes -> Orcad Demo-> Capture Cis Demo.

Une fenêtre Orcad Capture s’ouvre.

III-5-1-2) Créer un nouveau projet :

On choisit alors :

 Soit cliquer sur l’icône (Creat document) :

 Soit aller dans le menu :

File ->New -> Project
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Une nouvelle fenêtre s’ouvre pour nous demander le nom et le type de projet que nous

désirons, et le chemin où on veut le sauvegarder :

Figure III.37 : fenêtre de création d’un nouveau projet

Il faudra donner un nom « réaliste » fonction du schéma qu’on veut faire. Ce nom

devra avoir huit caractères au maximum, et pas de caractères bizarres (accents, tirets, …).

Pour faire un circuit imprimé, il faudra choisir le type PC Board Wizard.

Le chemin devra pointer vers le répertoire de travail soit C:\Programme

File\OrCAD_Demo\Capture\Exemplar.

On clique sur « Ok ».
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Capture nous propose alors de pouvoir simuler notre schéma, dans notre cas, cela ne nous

intéresse pas donc on clique sur Suivant.

Figure III.38 : fenêtre de simulation ou non simulation de projet

Il nous propose de charger des librairies par défaut pour notre schéma :

Figure III.39 : fenêtre de chargement des librairies

On clique sur « Terminer » (les librairies de symboles peuvent être ajoutées ultérieurement).

Capture crée alors deux nouvelles fenêtres :

 Une fenêtre Projet (à gauche),
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 Une feuille de schéma vierge (à droite).

Figure III.40 : fenêtre de gestionnaire de projet et la feuille de schéma

Dans la fenêtre de projet, on remarque :

 Le nom du projet dans la barre de titre : astable.

 Le nom de la feuille de schéma astable.dsn.

 Nous n’avons pas de librairies chargées, pas de fichiers de sortie,

 pas de composants dans le cache, et pas de projets référenciés.

La première action est de sauvegarder le projet, et la feuille de schéma. Pour cela, il faut

sélectionner la fenêtre de projet (sa barre de titre doit être bleue), puis de cliquer sur l’icône :

.

Cela permet de sauvegarder le projet mais pas la feuille de schéma, il faut maintenant cliquer

sur la feuille de schéma (sa barre de titre devient bleue) et recommencer l’opération de

sauvegarde.



Chapitre III Simulation des lignes de transmission et conception d’un circuit imprimé avec PSPICE

197

III-5-1-3) Saisie de schéma dans Orcad capture :

Saisie le schéma suivant sous Capture :

Figure III.41 : saisie de schéma sous Orcad capture

III-5-1-4) Vérification des règles électriques :

Il est temps de vérifier si notre schéma est correct du point de vue électrique. Pour

cela, commençons par sauvegarder notre schéma, puis fermons la fenêtre du schéma, puis

sélectionner la page du schéma dans la fenêtre de projet, puis le menu Tools -> Design Rules

Check ou l’icône .

Une nouvelle fenêtre s’ouvre pour nous proposer de modifier les options de DRC, ne rien

changer et faire OK.
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Figure III.42 : fenêtre de vérification des règles électriques

Le résultat des vérifications est mis dans un fichier .drc, et affiché dans la fenêtre Session

Log.

Figure III.43 : fenêtre des résultats de la vérification des règles électriques

Si le résultat est comme ci-dessus, ceci indique qu’il n’y a aucune erreur.
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III-5-1-5) Génération de la nomenclature :
On peut aussi obtenir la liste des composants du montage en faisant Tools -> Bill of material

ou cliquer sur l’icône :

Une nouvelle fenêtre s’ouvre, nous proposant des options, ne rien modifier et faire OK.

Figure III.44 : fenêtre de génération de la nomenclature

Un nouveau fichier avec l’extension .BOM, contenant la liste des composants est mis dans le

projet :
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Figure III.45 : apparition d’un fichier avec extension .bon dans le gestionnaire de projet

III-5-1-6) Recherche et assignations des empreintes :

Ré ouvrir la page schéma puis faire Edit -> Select All (ou Ctrl A), puis Edit Properties

(ou Ctrl E). La fenêtre des propriétés s’ouvre, choisir alors le filtre par Capture (Filter by

Capture), et l’onglet Parts.

On obtient alors la fenêtre ci-dessous :

Figure III.46 : fenêtre de l’éditeur de propriétés

On va s’intéresser à la colonne PCB Footprint, s’il y a des cases déjà remplies, les effacer, car

le choix par défaut n’est surement pas recommandé.
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Il reste maintenant à se procurer les composants réels pour connaître leur forme, et alors faire

l’association des empreintes aux symboles.

Cette étape est importante, car une même référence de composants, peut avoir plusieurs

formes différentes.

Une fois les composants sous les yeux, on peut alors rechercher leur FOOTPRINT dans le

Library Manager de Layout.

On va utiliser Orcad Layout. Pour lancer le programme, il faut :

Aller dans le menu :

Demarrer -> Tous les Programmes -> Orcad Demo -> Layout plus Demo.

Une fenêtre Orcad Layout s’ouvre, on choisit alors le menu Tools -> Library Manager :

Une nouvelle fenêtre s’ouvre avec les librairies de Footprints disponibles.

L’idéal est de pouvoir partager l’écran en deux parties, une avec Capture, l’autre avec Layout,

pour les avoir tous les deux ensemble à l’écran, comme ci-dessous :

Figure III.47 : fenêtre de recherche des empreintes

Rechercher alors dans les librairies du Library Manager, l’empreinte qui correspond le mieux

à notre composant. Une fois trouvé, faire un copier-coller du nom entre le Library Manager et

le property editor. Cela permet d’éviter ainsi les erreurs de frappe du nom de l’empreinte. On
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effectue cette opération pour tous les composants du schéma, et on  remplit ainsi toute la

colonne des PCB Footprint.

III-5-1-7) Création de la Netlist :

Une fois terminé, on referme la page du schéma, on sauvegarde, on sélectionne la

page, puis on fait : Tools-> Create Netlist, une nouvelle fenêtre s’ouvre, on choisit l’onglet «

Layout », on coche la case Run ECO to Layout, puis on sélectionne le bouton User Properties

in inches (surtout pas en millimètres).

Ensuite, on vérifie que le fichier Netlist (Netlist File) est bien sauvegardé dans notre espace

(C:\Programme File\OrCAD_Demo\Capture\Exemplar).

Figure III.49 : fenêtre de génération de la netlist
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III-5-2) Sous Layout :

III-5-2-1) Création d’un nouveau typon :
On lance Layout, puis on choisit File -> New. Une nouvelle fenêtre s’ouvre, pour nous

demander le Fichier de Gabarit (Template File) qui est situé dans le répertoire C:\Program

Files\OrCAD\LAYOUT\DATA,par la suite,on choisit le fichier 2faces.tch pour faire un

circuit à deux faces.

Figure III.50 : choix du nombre de faces du circuit

Mais dans le cas présent, on n’a pas la possibilité de faire un circuit à deux faces, c’est pour

cela qu’on choisit « DEFAULT.TCH » ce qui veut dire qu’on travail sur 4 faces, et on en

supprime deux par la suite.

On clique sur « Ouvrir ».

Une nouvelle fenêtre s’ouvre, on doit lui fournir le fichier Netlist qu’on avait  créé

précédemment, on va le chercher là où on l’a mis (C:\Programme

File\OrCAD_Demo\Capture\Exemplar).
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Figure III.51 : ouverture d’un fichier netlist

On sélectionne « ASTABLE1.MNL », on cliquer sur « Ouvrir ».

On sauvegarde le typon avec le nom du projet accompagné de l’extension .MAX . puis on

enregistre. Une fenêtre de travail s’ouvre pour nous détailler l’importation du fichier, si tout

se passe bien, la fenêtre se referme et on a le chevelu de notre circuit ci-dessous :

Figure III.52 : le chevelu du circuit
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Remarque :

Dans le cas, où on n’a pas pu avoir le chevelu, on note le composant en cause, et on clique sur

Cancel, on quitte Layout et on corrige le problème dans Capture, puis on génère la netlist.

III-5-2-2) Placement des composants :

On choisit l’outil Component Tool en cliquant sur cette icône .

On clique sur un composant, pour le prendre, le déplacer à l’endroit voulu (un appui sur la

touche R permet de lui faire  une rotation de 90°), et on reclique pour le lâcher.

On effectue cette opération pour tous les composants.

III-5-2-3) Prévoir les trous de fixations :

Pour pouvoir fixer le circuit dans son boitier, il faut prévoir les trous de fixation. Pour

cela on sélectionne l’outil composant Component Tool, puis un clique droit « New », une

fenêtre s’ouvre. On clique sur le bouton Footprint, on choisit la libraire empreintes, puis le

composant Vis.

Figure III.53 : fenêtre de sélection d’un trou de fixation

On place le composant vis à l’endroit voulu, et on  recommence l’opération autant de fois que

nécessaire.
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III-5-2-4) Tracé du circuit imprimé :
Pour tracer le contour de la plaque, il faut choisir l’outil Obstacle Tool en cliquant sur

icône suivante :

Se mettre dans le coin du cadre à dessiner puis faire un clique droit, puis New,en suite on

dessine le cadre (qui doit être à 20 mils des composants). On vérifie que le cadre est un Board

Outline, et qu’il est sur le Global Layer.

III-4-2-5) La suppression de couches supplémentaires :

Au début, on a travaillé sur quatre couches au lieu de deux, maintenant on doit

supprimer les deux couches supplémentaires, pour cela on clique sur : puis on choisit

Layers, une fenêtre s’ouvre elle nous indique le nombre de couches utilisées dans notre

exemple, on sélectionne les couches supplémentaire dans notre cas puis on clique sur le

bouton droit de la souris, on choisit properties…,une autre fenêtre s’ouvre, on choisit la

suppression des couches en validant « Unused Routing », on clique sur « Ok », et toutes ces

explications sont illustrées dans la figure suivante :

Figure III.54 : fenêtre de sélection et de suppression de deux couches
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III-5-2-6) Vérification de la faisabilité :
Pour savoir si notre circuit va être « routable facilement », on peut  avoir une

identification des zones à risques. Cliquant sur View -> Density Graph ->Fine, Une nouvelle

fenêtre s’ouvre, elle nous indique en rouge les parties difficiles à router, en bleu les parties

faciles :

Figure III.55 : fenêtre de vérification de la faisabilité du circuit

Interprétation :

Dans notre cas, on relève que la couleur rouge n’est pas dominante, ce qui implique que le

placement des composants est correct, d’où le routage sera facile.
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III-5-2-7) Avant de passer à la phase de routage :
Il faut vérifier qu’il ne reste plus de composants en dehors du contour, on affiche le

tableau de statistiques : menu « Auto » -> « Refreh » -> « Calcul statistics » ou l’icône tableau

« spreadsheet » de la barre d’outils puis on choisit « statistics ».

Figure III.56 : fenêtre de vérification des composants se trouvant à l’intérieur ou à

l’extérieur du contour

On vérifie effectivement qu’il ne reste plus de composants en dehors du contour : La valeur
de « Off board » doit être égale à zéro.
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III-5-2-8) Routage :
III-5-2-8-1) Routage manuel :

On commence par une optimisation du chevelu. Pour cela on lance la commande Menu :

Auto -> Refresh -> Minimize connections.

a) Router une piste :

On clique sur l'outil « Add /Edit route Mode » puis sur un chevelu du circuit avec

l'outil DRC actif (bouton DRC activé , celui-ci vérifie si le routage de la piste que nous

sommes en train de réaliser respecte les règles d'isolations), puis on choisit la face ou la

couche où on désire débuter notre piste :

 pour la couche ou la face BOTTOM, on appuie sur la touche « 2 » du clavier
alphanumérique,

 pour la couche ou la face TOP, on appuie sur la touche « 1 » du clavier
alphanumérique.

Une fois qu’on a sélectionné la face et un chevelu, on route la piste à l'aide de la souris.

b) Options possibles :

 Pour changer de direction, on clique sur le bouton gauche de la souris et on continue
le tracé de la piste.

 Pour insérer un via ou changer de couche, on clique sur le bouton gauche de la souris

et on appuie sur la touche correspondant à la couche où on souhaite continuer le

routage («1»:TOP ou « 2 » : BOTTOM) et on continue la piste.

 Pour échanger les extrémités de la piste, on appuie sur la touche « X ».

 Pour augmenter la taille de la piste, on appuie sur la touche « W».

 Pour effacer un segment routé, on clique dessus et on appuie sur la touche

« SUPPR ».

 Pour terminer la piste, on appuie sur la touche « F » ou sur le bouton droit de la souris

pour faire apparaître le menu contextuel.

c) Règles de routage :

Les règles de routage sont :

 Pas d’angle droit,

 Faire les pistes les plus courtes possibles,

 Evitez les angles trop longs,
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 Effectuer les croisements de préférence sur une pastille,

 Ne pas faire arriver 2 pistes à moins de 90° sur une pastille,

 Ne pas faire de boucles, essayer de router en étoile,

 Laisser un pas au minimum par rapport au bord du circuit,

 Respecter l’isolation entre pistes, s’il y a de fortes tensions,

III-5-2-8-1) Routage automatique :

a) Routage sans stratégie:

On Lance la commande d'autoroutage : menu Auto -> Autoroute -> Board , puis la

commande d'optimisation de tracé de LAYOUT, Menu Auto -> Cleanup Design .

b) Routage dit X ,Y (X pour le côté composant et Y pour le côté cuivre) :

Il faut charger un fichier de stratégie pour le routage automatique, pour cela, on choisit dans

le menu File la commande « LOAD » et le fichier stratégie « 2_thr_v.sf».

Figure III.67 : fenêtre de chargement d’un fichier de stratégie

Ce fichier de stratégie correspond à une stratégie optimisée pour le routage en X,Y : vertical

pour le côté BOTTOM (2) et horizontal côté cuivre (1).
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On lance ensuite la commande d'auto routage : menu Auto >- Autoroute  DRC / Route Box,

puis la commande d'optimisation de tracé de LAYOUT, Menu Auto -> Cleanup Design.III-

5-2-8-3) Modifier un segment :

Pour modifier un segment on clique sur l'outil d'édition de segment , Puis on clique sur le

segment à modifier et on déplace la souris, le segment de la piste change de position, enfin on

clique sur le bouton gauche de la souris pour fixer le segment.

III-5-2-9) Placé des plans de masse :

On sélectionne la couche où on veut réaliser un plan de masse (1 : TOP : côté

composant et 2 : BOTTOM : côté cuivre).

On sélectionne l'outil « Obstacle» .

On clique sur le bouton gauche de la souris pour commencer le plan de masse.

On presse de nouveau le bouton gauche de la souris à chaque fois qu’on veut changer de
direction.

On sélectionne la zone dessinée, en cliquant dessus, puis on appuie sur le bouton droit de la
souris pour faire apparaître le menu contextuel.

Figure III.58 : choix du type d’obstacle
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Les informations importantes de cette boîte de dialogue sont :

 Obstacle type : « Copper Pour » (Zone pleine)

 Obstacle layer : « BOTTOM » (La couche où va s'appliquer le plan de masse)

 Net attachement : « 0 » (La masse)

Remarque :

Il est indispensable de mettre des zones cuivrées qui sont associées au plan de masse

sur une partie analogique, correspondant à une forte amplification, mais dans d’autres cas, le

plan de masse  n’est pas nécessaire comme dans le cas présent.

III-5-2-10) Placé de texte :

On sélectionne l'outil texte « Text Tool » et la commande « New » à partir du

menu contextuel. La boîte de dialogue « Text Edit » s'affiche.

Figure III.59 : fenêtre de l’éditeur de texte

Les informations importantes de cette boîte de dialogue sont :

 Text String : le texte à afficher.
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III-5-2-11) Sauvegarde :

La sauvegarde du schéma s'effectue en cliquant sur l'icône (Save Document) ou

en choisissant File -> Save ou raccourci clavier « CTRL + S ».

III-5-2-12) Vérification que toutes les pistes ont été bien routées :
On Utilise l’outil de statistiques de « Layout », Menu Auto -> Refresh -> Calcul

Statistics ou l’icône tableau de la barre d’outils puis on choisit « statistics ».

Figure III.60 : fenêtre de vérification du pourcentage de routage

On vérifie que l’information « % Routed » est égale à 100%.

On applique la commande suivante pour optimiser le tracé des pistes, menu « Auto » -> «

Cleanup Design ».
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Le résultat de réalisation du circuit imprimé est représenté ci-dessous :

Figure III.61 : circuit imprimé de l’astable

III-5-2-13) Imprimer les différentes faces du circuit imprimé :

III-5-2-13-1) Vérification qu’il ne reste pas d’éléments en dehors du circuit imprimé :

En effet, il arrive que par mégarde lors d’un routage d’un circuit imprimé, on laisse

de côté certains attributs de composants, tels que du texte ou des obstacles en dehors du

circuit. Pour s’assurer qu’il ne reste pas d’éléments à l’extérieur du contour, on appuie sur le

bouton « Zoom All » de la barre d’outils.

On doit voir l’ensemble de la carte à l’écran, la carte doit occuper pratiquement tout l’écran.

Si oui, on peut passer à l’impression.

Dans l’autre cas, il faut rechercher les éléments qui restent en dehors de la carte, ils ne sont

pas forcément visibles, pour cela :

 on clique sur l’outil texte de la barre d’outils, puis en dehors du circuit, on sélectionne

la zone qui part du haut de l’écran jusqu’au bord supérieur de la carte. Si le curseur

change de forme (petit curseur) c’est qu’il existe des éléments de textes non visibles,

alors on appuie  sur la touche « Suppr » du clavier pour les effacer.
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 On répète cette opération tout autour de la carte.

 On fait de même en sélectionnant l’outil « obstacle » de la barre d’outils.

 Ensuite on appuie  de nouveau sur le bouton « Zoom All » de la barre d’outils, et on

doit voir l’ensemble du circuit imprimé.

III-5-2-13-2) Imprimer toutes les couches du circuit imprimé :

On sélectionne la commande « Post Process Settings » du menu « Options », le tableau

de «POST PROCESS » va s’afficher.

Figure III.61 : le tableau Post Process

Ensuite, on appuie sur le bouton droit de la souris dans le tableau de « POST PROCESS » et

on sélectionne la commande « Run Batch ».
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III-5-2-13-3) Imprimé d’une couche du circuit :

III-5-2-13-3-1) Le coté composant :

On sélectionne la commande « Post Process Settings » du menu « Options », le tableau

de « POST PROCESS » va s’afficher.

On clique dans la case « *TOP » puis sur le bouton droit de la souris pour faire apparaître le
menu contextuel.

On choisit la commande « Plot to Print manager », la fenêtre d’impression de l’imprimante

va apparaître, on sélectionne l’imprimante où nous voulons imprimer, et on valide par le

bouton « OK ».

Figure III.62 : le coté composant du circuit imprimé

III-5-2-13-3-2) Le coté cuivre :

On sélectionne la commande « Post Process Settings » du menu « Options », le

tableau de « POST PROCESS » va s’afficher.

On clique dans la case « *BOT » puis sur le bouton droit de la souris pour faire apparaître le

menu contextuel.

On choisit la commande « Plot to Print manager », la fenêtre d’impression de l’imprimante

va apparaître, on sélectionne l’imprimante où on veut imprimer , et on  valide par le bouton «

OK ».
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Figure III.63 : le coté cuivre du circuit imprimé

III-5-2-13-3-3) Le coté sérigraphie (sst) :

On sélectionne la commande « Post Process Settings » du menu « Options », le

tableau de « POST PROCESS » va s’afficher.

On clique dans la case « *.SST » puis sur le bouton droit de la souris pour faire apparaître le

menu contextuel.

On Choisit la commande « Plot to Print manager », la fenêtre d’impression de l’imprimante

va apparaître, on sélectionne l’imprimante où nous voulons imprimer, et on valide par le

bouton « OK ».
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Figure III.64 : le coté sérigraphie du circuit imprimé

III- Discussion :

D’une part, on a modélisé des lignes de transmission, simulé en changeant les différents

paramètres associés, afin de voir leurs influences sur l’entrée et la charge de la ligne.

D’autre part, on a réalisé un circuit imprimé, en décrivant toute les étapes de fabrication.

En récapitulant, qu’une fois la « philosophie PSpice » en tête, beaucoup de détails

apparaissent d’eux-mêmes, suivant une certaine logique des concepteurs. On se sent plus à

l’aise, et on peut découvrir certaines fonctionnalités de façon intuitive.
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Conclusion :

Cette étude, nous a permis de :

 Savoir dessiner un schéma, configurer une simulation sous Pspice, et la lancer sans

essayer de suite l’optimisation.

 Savoir simuler en écrivant un programme en langage Spice.

 Savoir réaliser un circuit imprimé sous OrCAD Capture- Layout.

Lors de cette étude, nous avons montré que l’outil Pspice permet de posséder un véritable

labo de mesure et d’essai, à moindre coût, et dans un espace restreint. De plus nous sommes

arrivés à mettre en évidence la concordance des résultats obtenus par simulation avec les

résultats théoriques et pratiques.

A partir de la création du schéma d’un montage dont les composants sont décrits par les

modèles fournis en général par les fabricants de semi-conducteurs, PSPICE permet de simuler

le fonctionnement du circuit et de l’analyser finement, tant du point de vue des grandeurs

continues que dans le domaine temporel ou fréquentiel. On peut dire que l’outil regroupe en

même temps les fonctionnalités de mesure du multimètre, de l’oscilloscope et de l’analyseur

de spectre.sa puissance ne s’arrête pas là, on peut réaliser des analyses paramétriques, c’est-à-

dire représenter la variation d’une grandeur du circuit en fonction de la variation d’une autre,

pas nécessairement le temps ou la fréquence.

Nous avons également étudié les différentes étapes de fabrication d’une carte

électronique, en d’autre terme, réalisation d’un circuit imprimé en montrant toute les

fonctionnalités de Layout. Cette richesse de fonctionnalités n’est pas limitée uniquement à

cela, car on peut également réaliser des circuits logiques programmables. Des outils

d’optimisation, de prise en compte des caractéristiques maximales sont aussi disponibles (non

traité dans cette étude) ce qui confère à Pspice une référence mondiale dans le domaine de la

conception, et de la simulation de circuits électriques et électroniques. Enfin nous pouvons

dire que ce travail nous a permis de comprendre et de  savoir exploiter ce logiciel qui nous a

émerveillées.
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